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Disclaimer

NEC shall not be liable for any direct, indirect, consequential or incidental damages about the use of this
equipment, manual or any related materials. 

The information in this technical manual is advisory in nature and is subject to change. NEC may make
improvements and changes in the products described in this manual without notice. Changes will be
periodically made to the information in the new editions. 

Efforts have been made to ensure that the contents of this manual are correct. Should you find any error,
NEC welcomes your comments to improve our communications, please contact NEC on 1800 036 136.

Contents of this manual are subject to change without prior notice at the discretion of NEC Business
Solutions Ltd. 

This document has been prepared for the use of employees and customers of NEC Business Solutions
Ltd and may not be reproduced without the prior, written approval of NEC Business Solutions Ltd.

Copyright © 2004
NEC Business Solutions Ltd
633 - 647 Springvale Road

Mulgrave Vic 3150
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Introduction to IPK
ACD Plus Chapter 1

SE C T I O N 1
INTRODUCTION

IPK ACD Plus is a feature-rich call handling system that consists of the
following main functions:

Auto Attendant (AA)
Automated Call Distributor (ACD)
After Hours Attendant (Night Mode)

IPK ACD Plus performs as an AA only, ACD only, or both an AA and an
ACD. The entire functionality (AA and ACD) exists and is enabled in every
unit. IPK ACD Plus may be programmed to answer some lines with the auto
attendant while sending others directly into the ACD functionality. IPK ACD
Plus allows call transfers to both on-premises and off-premises destinations
via Centrex transfer. 

SE C T I O N 2
OVERVIEW

The IPK Automatic Call Distribution (ACD) Plus is a series of Windows-
based software programs designed to enhance the ACD features of the
IPK Key Telephone System. The software displays both real-time data and
historical reports.

IPK ACD Plus has many beneficial features:

Easy installation
Cost-effective call and staff management tool
Quick access to both real-time and historical data
Easy to read reports and graphs
User-friendly screens

The IPK ACD Plus saves your company money by providing a cost-effective
method of capturing, displaying, and reporting ACD group call traffic and
staff activity. These reporting tools help your company evaluate its staffing
requirements and agent performance.

In addition to providing an excellent means of monitoring call activity and
agent performance, IPK ACD Plus ensures quick access to call traffic
reports, wait time reports, and agent time logs. You receive valuable
information when you need it in a clear format.
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The IPK ACD Plus program suite requires a Personal Computer (PC)
running Windows 95/98, NT, 2000, XP, or XP Professional operating
system. 

Due to updates in software after the publication of this document, some of
the screen displays shown in this manual and listed features may differ
slightly from your version of IPK ACD Plus. 

SE C T I O N 3
IPK ACD PLUS 
COMPONENTS

IPK ACD Plus has four main system components:

IPK ACD Plus Server
IPK ACD Plus Monitor Client
IPK ACD Plus Administration Client
IPK ACD Plus RTD Client

3.1 IPK ACD Plus Server

The IPK ACD Plus Server program is responsible for setting up
communication with the NEC KSU and recording call activity to an
external database. The server should be left running at all times so
that call records can be properly stored. The server is capable of
running in a foreground or background window. The server
application is added to the startup tasks so that it will auto-start when
the PC is turned on. 

NEC recommends that the Server PC be a dedicated system
reserved exclusively for IPK ACD Plus programs.

Once initiated, the program begins to accept data from the KSU after
15 ~ 20 seconds. 

IPK ACD Plus must be running in order to properly collect all
call record activity (i.e. the program must be active or must be
minimised). Refer to <Blue Text> Installing & Configuring Elite ACD
Plus on page -11.

3.2 IPK ACD Plus Monitor Client
The IPK ACD Plus Monitor Client program can run on the Server PC,
or run on a networked PC (client). No password is required to run the
Monitor client, however, there is a maximum number of five
simultaneous Monitors that can be active. The number of
simultaneous Monitors is dependent upon the product licensing. In
addition, each PC running client software must have a Client Key
installed. For more information, refer to <Blue Text>Chapter 3, <Blue
Text>Figure 3-5: Client Key Error Message on page -17.

If IPK ACD Plus Monitor is started on the same PC as the server, it
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registers with the server and begins displaying ACD group data
immediately. If the program determines that it is running on a
network machine, then the operator must enter the network address
or network machine name of the Server PC. At that time the monitor
is registered with the server and the ACD group data is then
displayed. The monitor displays real-time queue information.

When running in real-time mode, the Monitor displays a real-time
screen upon start-up that depicts real-time queue information. From
within the real-time screen, select a particular report from the
Reports menu to obtain historical call information for viewing or
printing. 

The Monitor user interface provides real-time queue information for
all ACD groups: 

The current status of all agents.
The selected report in chart format.
The queue status (number of agents logged in, number of calls
in queue, and longest wait time of calls in queue).
An ACD group task summary for user-defined period (average
time talking with agent and average hold time, number of
abandoned calls, and number of answered calls).

3.3 IPK ACD Plus Administration Client
The IPK ACD Plus Administration Client program (Admin) is used to
set up and configure the ACD operation to match the KSU telephone
set up.

The Administration Client allows you to perform all facets of IPK
ACD Plus programming via a personal computer (PC) connected to
the network, or on the same PC as the Server. The operator can also
save a configuration to a local file and upload that configuration to
the ACD at a later time.

The capability to transfer custom voice files from the PC to the IPK
ACD Plus is also provided. These voice files can be used for any of
the Auto Attendant (AA), ACD, or Night Mode messages and would
take the place of the default messages provided by NEC.

3.4 IPK ACD Plus Real Time Display Client
The Real Time Display (RTD) feature consists of a server application
that will be installed on the same PC running the ACD Plus server
software, and client software that will be installed on the Agent PCs.
This application provides real time queue and agent information to
the individual desktop. This provides a cost effective alternative to
expensive wall displays that display queue status information. In
addition to the queue and agent status information, the application
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will also allow text messaging to be sent to individual agents and
groups of agents.

IPK ACD Plus Software Suite V2.01 or higher is required to support
the RTD feature.

An optional RTD License Key is available to support additional RTD
clients.

Without an RTD License Key, up to three RTD clients are
supported.
With an RTD License Key, up to 100 RTD clients are supported.
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Features Chapter 2

SE C T I O N 1
FEATURES

This chapter describes the following features of IPK ACD Plus.
Line Monitoring
Direct Extension Dialling

IPK ACD Plus Message Buffering

1.1 Line Monitoring
IPK ACD Plus continually monitors its ports for messages from the
Xen IPK indicating a call is present on a trunk line that is assigned to
be answered by IPK ACD Plus. Lines are assigned in the
Administration Program. IPK ACD Plus lets you program the number
of rings (0~9) prior to answer.

1.2 Direct Extension Dialling 
You can dial an extension at any time while the call is active on the
port (i.e. a message is playing). 

The number that you dial must meet certain requirements. IPK ACD
Plus accepts only Directory Numbers (DNs) as direct extension
dialling destinations (no off-switch numbers). The number of digits
dialled must correspond with the number of digits programmed in the
dialling plan of the associated Xen IPK and not exceed seven digits. 

IPK ACD Plus never allows you to enter more than seven digits. If
you dial a non-valid extension, IPK ACD Plus plays a message
stating “That is not a valid extension” followed by replaying the
prompt that was playing when the caller attempted to dial an
extension. 

IPK ACD Plus automatically enables Direct Extension Dialling if the
AA functionality is enabled. Direct Extension Dialling is enabled/
disabled for each ACD group in the Administration Program and is
disabled by default.

1.3 IPK ACD Plus Message Buffering 
If there is no device connected, IPK ACD Plus retains (buffers) all the
call record messages for later export to a computer running IPK ACD
Plus. Once the buffer file size reaches four megabytes, no further
records are saved. The buffer file is uploaded by the Administration
Program. IPK ACD Plus also acts as a buffer when the device
connected to the RS-232 port is not receiving data. Once IPK ACD
Plus has determined the device has resumed receiving data, IPK
ACD Plus transmits the stored call records.
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SE C T I O N 2
AUTO ATTENDANT (AA)

IPK ACD Plus has a single tree, nine option Automated Attendant (AA). In
Auto Attendant mode, IPK ACD Plus answers the assigned lines and plays
an Auto Attendant message. While the message is playing, IPK ACD Plus
monitors the line for signals indicating the caller’s transfer choice. The AA
has the following capabilities:

Internal Transfers

External Transfers - Centrex
Transfer to ACD Queue

Default Transfer

2.1 Internal Transfers
The Auto Attendant can transfer a call to any valid DN on the key
system. Dialling or programming the AA to transfer to “0” (zero) will
transfer the call to the station port programmed as the operator. IPK
ACD Plus does not monitor an AA transfer to ensure completion of a
call. KSU programming will dictate the call flow for unanswered
transfers (call forward busy, call forward no answer). 

2.2 External Transfers - Centrex
The AA can transfer a call to any valid telephone number using
Centrex service. The call is transferred at the Central Office and
once transferred does not use any Xen IPK trunk lines.

2.3 Transfer to ACD Queue
The AA will transfer to the ACD queue if so programmed. If the agent
is unavailable, the ACD greeting message will play. Refer to Section 4
ACD on page -7.

2.4 Default Transfer
If the caller does not select an AA transfer option within eight
seconds after the AA message has finished playing, IPK ACD Plus
will automatically transfer to the transfer destination number for that
line. The transfer destination number can be any internal or external
number and will utilize Centrex features if available and so
programmed. If there is no transfer destination number assigned,
IPK ACD Plus replays the AA message after eight seconds.
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SE C T I O N 3
FREQUENTLY ASKED 
QUESTIONS (AA)

Listed below are some frequently asked questions concerning the
Automated Attendant feature:

What is the default Auto Attendant message?

The AA message is not recorded at default. The AA message can be
recorded on a supervisor telephone or recorded on a PC and transferred
as part of the administration program. An example of an AA message is:

“Thank you for calling. If you know your party’s extension dial it now. If
you wish to speak with the operator, press 0.” 

What happens if the caller selects an invalid option?

If a caller selects an AA option that does not have a transfer destination
or selects an un-programmed transfer option (including an erased
option), IPK ACD Plus responds with the following message:

“You have made an invalid selection, please try again.” 

After this message plays, IPK ACD Plus will repeat the AA message.

How can the caller replay the Auto Attendant message?
The caller presses J to replay the AA message. 

SE C T I O N 4
ACD

IPK ACD Plus allows up to 108 Agent and Supervisor IDs, but only 40
active agents plus 12 supervisors can be logged in at one time. They can be
placed into a maximum of four Automatic Call Distributor (ACD) queues.
The default setting for the ACD function in the IPK ACD Plus is disabled.

ACD Distribution Methods
IPK ACD Plus has two methods of distributing calls to call takers (agents):
longest idle and preferred routing. Longest idle is simply the agent who has
been idle the longest. Preferred routing allows the end user to assign
priority distribution to agents. Each method is described next in more detail.

4.1 Longest Idle ACD Distribution Method
The Longest Idle ACD Distribution Method distributes a call to the
logged in agent who has been idle the longest. Calculations for
longest idle time begin when an agents' status becomes IDLE. Wrap
and Non-ACD call states have an affect on the agent distribution
order for longest idle call distribution. 

4.2 Preferred Agent ACD Distribution Method
The Preferred Agent ACD Distribution Method distributes a call to
agents in preferential order based upon an agent’s level (1~9). IPK
ACD Plus allows nine levels of agents. Level One agents are tried
first, Level Two agents tried second, etc. Within each agent level,
IPK ACD Plus uses Longest Idle distribution. For instance if there
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are three available agents in level one, the agent that has been IDLE
the longest will be distributed the next call. All Longest Idle rules
apply within each preferred level.

4.3 Agent States ACD Distribution Method
The Agent States ACD Distribution Method tracks agent states using
the IPK ACD Plus Monitor software program. The table below shows
the valid agent states and state descriptions for IPK ACD Plus. 

Agents login to the ACD by dialling the ACD port pilot number. The
IPK ACD Plus system will answer this call and prompt the caller for
their ID and password via the telephone’s display. Once logged in, an
agent can manually change states for Login/Logout, Break/Breakoff,
and Wrap/Wrapoff by pressing softkeys on their terminal. 

The remaining states are controlled by IPK ACD Plus and will
depend upon call activity. In most cases, an agent is allowed to enter
a state change request (using softkeys) while in another state. The
requested state will become active only after the current state is
changed. For instance, if an agent is on a call, the agent may request
to be placed in wrap mode. Wrap would not become the active state
until the call is released. If an agent enters the same request multiple
times without exiting the current state, the last state request is the
only request that is honored. For example, an agent that is logged in
and on a call and requests a WRAP three times, once the call is
released the agent is in the WRAP state (Wrap On, Wrap Off, and
Wrap On). The table below shows the affect different stimuli have on
agent states. 

Table 2-1:  Agent States and Descriptions

State Description

Idle Agent is available to take an ACD 
call (must also be logged in)

ACD Call Agent is off-hook on an ACD call

Wrap Agent is in Wrap mode and can 
finish entering important data 
concerning the previous call

Non-ACD Agent is off-hook on a non-ACD call

Logged-Out Agent is logged out of the ACD 
queue

Break Agent is on a break
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 Table 2-2:  Agent States and Stimuli

State Stimulus New State

Idle LOUT (Logout) request Logged out

Idle Wrap request Wrap

Idle ACD call presented ACD call

Idle Off-hook Non-ACD call

Idle Break Mode request Break

Wrap Wrap off request Idle

Wrap LOUT (Logout) request Logged out

Wrap Off-hook Non-ACD call

Wrap Break Mode request Break

ACD Call LOUT (Logout) Logged out

ACD Call Wrap request Wrap

ACD Call Release Idle

ACD Call Break Mode request Break

Non-ACD 
Call LOUT (Logout) Logged out

Non-ACD 
Call Wrap request Wrap

Non-ACD 
Call Release Idle

Non-ACD 
Call Break Mode request Break

Break Break off request Idle

Break LOUT (Logout) request Logged out

Break Off-hook Non-ACD



June 2004 NEC Business Solutions Ltd

10 – Chapter 2

D
oc

. N
o.

 8
20

1 
- R

el
ea

se
 1

.0
Ju

ne
 2

00
4

THIS PAGE INTENTIONALLY LEFT BLANK



Automatic Call Distribution (ACD) User Guide Chapter 3 – 11

D
oc

. N
o.

 8
20

1 
- R

el
ea

se
 1

.0
Ju

ne
 2

00
4

Installing & Configuring   
XenIPK Plus Chapter 3

SE C T I O N 1
HARDWARE AND 
SOFTWARE 
REQUIREMENTS

The following items are required for IPK ACD Plus.

1.1 ACD Plus Software Requirements
Microsoft Windows 95/98, 2000, NT, XP, or XP Professional
operating system. 

1.2 ACD Plus Hardware Requirements
IBM-compatible machine with at least a Pentium III 500 MHz
CPU system or equivalent.
Minimum 40 MB of available hard disk space
Minimum 128 MB of RAM
l If the PC will be used for all applications, RTD,

Administration, Monitor, and Server, 256 MB of RAM is
required.

l The ACD Server with RTD Server running on the same PC
needs 256 MB of RAM and 128 MB RAM for RTD client is
required.

CD-ROM drive
Unused serial port for connecting to the KSU
Mouse
Printer (optional)

As with most Windows applications, running the software on a faster
PC with increased memory can improve operation. Applications that
work in real-time, like IPK ACD Plus, are especially sensitive to the
need for an efficient hardware system. If your system processes
several applications, or is slow in processing real-time data, NEC
suggests upgrading the speed and/or RAM capacity or your PC. 

NEC strongly suggests running the server on a dedicated PC.
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SE C T I O N 2
PARTS LISTS

The various items required for running IPK ACD Plus are listed next.

2.1 Xen ACD Plus Kit
The following items are included in the IPK ACD Plus Kit:

(1) IPK ACD Plus Suite CD-ROM
(1) IPK ACD Plus Documentation CD-ROM (includes IPK ACD
Plus Installation Manual and Supervisor’s Guide)
(1) Client Key
(1) Flat ribbon serial cable
(20) Agent User’s Guide

The following items are not included in the IPK ACD Plus Kit, but
may be needed:

DB-9 to DB-25 adaptor, if needed
Serial cable

2.2 Optional Wallboard Unit
The following items are included with the Wallboard:

4-wire non-reversing cord
Wallboard
AC adaptor

To connect the wallboard, the Wallboard Installation Kit is required.

2.3 Wallboard Installation Kit
The following items are included with the Wallboard Installation Kit:

DB-9 RS-232 splitter cable
DB-9 to DB-25 adaptor, if needed (not provided)
RS-232 to RS-485 converter

2.4 Upgrade for 2-Line Sign Requirements
To upgrade to a 2-Line Sign, the following items must be purchased:

Optional Wallboard Unit

Wallboard Installation Kit

2.5 KTS Requirements
In order for the IPK ACD Plus feature to properly run, these items are
required:

Xen IPK Telephone System revision 1.00 or higher or Xen IPK
software revision 6.00 or higher
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Dterm  Series i, Dterm Series E, Xen, or Xen IPK Telephones with
softkeys

SE C T I O N 3
CONNECTING THE IPK 
ACD PLUS SERVER TO 
THE KSU 

3.1 Connecting the IPK ACD Plus Server to the KSU without a 
Wallboard
To connect the IPK ACD Plus Server to the KSU without a wallboard:

1. Connect the Server PC to the LAN.

2. Connect the ACD(8)-U30 ETU to the same LAN.

OR

1. Connect one end of the serial cable into the available serial port
on the Server PC. Use a DB-9 to DB-25 converter (not provided),
if necessary.

2. Connect the other end of this cable to the ACD(8)-U30 ETU
port’s ribbon extension cable, located toward the front of the
KSU. 

Figure 3-1:  Connecting IPK ACD Plus Server to the LAN Network

ACD(8)-U30 ETU

Front View of KSU

Network Cable

Back View of PC

LAN Network

LAN
RJ45

LAN
RJ45

Network Cable
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3.2 Connecting the IPK ACD Plus Server to the KSU with a
Wallboard
To connect the IPK ACD Plus Server to the KSU with a Wallboard:

1. Connect the serial cable to the available serial port on the Server
PC or connect via the LAN to the ACD(8)-U30. If using the LAN,
skip to step 4.

2. Connect the serial cable to the ribbon cable. 

3. Connect the ribbon cable to the J11 connector jack on the
ACD(8)-U30 ETU.

4. Verify that another serial port is connected to the DB-9 RS-232 to
RS-485 converter (provided).

5. Run a 4-wire non-reversing line cord (house wiring may be used)
between the DB-9 RS-232 to RS-485 converter and wallboard
display. 

6. Turn on the Run/Shutdown switch located on the ACD(8)-U30
ETU.

Figure 3-2:  Connecting IPK ACD Plus Server without a Wallboard

ACD(8)-U30 ETU

Front View of KSUSerial Cable

Back View of PC

Serial Port ACD(8)-U30 
Ribbon Cable 

Extension
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3.3 Connecting the IPK ACD Plus Monitor to the
Wallboard
When using the Monitor Client on a remote network PC, you
can connect the remote PC to a Wallboard. 

To connect the IPK ACD Plus Monitor  to the Wallboard:

1. Connect the RS-232 to RS-485 converter to the available
COM port on the Monitor PC. Use a DB-9 to DB-25
converter (not provided), if necessary.

2. Run a 4-wire non-reversing cord (house wiring may be
used) between the RS-485 converter and the wallboard

Figure 3-3:  Connecting IPK ACD Plus Server to the KSU with a Wallboard

ACD(8)-U30 ETUACD(8)-U30 ETU Ribbon 
Cable Extension

Serial Cable

RS-232 to RS-485
Converter

4-Wire Non-Reversing
Line Cord

Wallboard Display

Back of PC

Serial Ports
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display(s).

SE C T I O N 4
NETWORK SUPPORT

The IPK ACD Plus programs can be configured to communicate on a TCP/
IP or NETBIOS network. Network support is available depending on the
software license that is purchased. 

It is assumed that the network configuration is already functioning. If
network support is needed, contact the network administrator.

Remember that the Monitor and ADMIN programs require the IP address, or
machine name, of the Server PC . If the Server PC has a roving address,
make sure that a valid name server is present on the network so the
machine name can be used in place of the hard-coded IP address.

Installation Complexity with Shared Office 97™ Resources

The IPK ACD Plus Server utilises a Microsoft Access™ database for
historical archive of call records originating from the KSU ACD.

Figure 3-4:  Network PC Connected to a Wallboard and Running 
Monitor Client 

The Elite ACD Plus Server requires installation of the Microsoft
Data Access Components version 2.1 or higher. If Microsoft
Office is accessed from the network, an administrator with write
access to the Office installation directory will need to perform the
Server installation.

!
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SE C T I O N 5
INSTALLING IPK ACD 
PLUS SOFTWARE

This section outlines the basic installation procedure for installing IPK ACD
Plus on a computer via the CD-ROM.

5.1 Client Key
For the client software (Admin and/or Monitor) to run on a PC, that
PC must have a Client Key attached to the LPT1 or printer port. If the
Client Key is not installed, the following error will be displayed and
the application will stop functioning.

A maximum of five active Clients can be simultaneously connected
to one Server.

5.2 Installing IPK ACD Plus Suite
Before installing IPK ACD Plus, be sure that any previously installed
versions of IPK ACD Plus are completely removed.

To remove previous versions of IPK ACD Plus or Demo:

1. From the Windows Control Panel, select Add/ Remove
Programs. 

2. Select previously installed versions of IPK ACD Plus or Demo for
uninstall.

3. If prompted to delete files, click Yes. 

All Windows programs and applications must be closed prior to
executing this startup procedure.

1. Insert the IPK ACD Plus Suite CD into the CD-ROM drive.

2. Choose Run from the Start menu.

3. In the Command Line box, type d:\Disk1\setup.exe. 
If the CD-ROM drive is associated with a different drive letter,
type the appropriate letter (i.e., e:\Disk1\setup.exe).

Figure 3-5:  Client Key Error Message
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OR
Click Browse and locate setup.exe on the CD-ROM.
Double click on setup.exe.

4. Click the OK button.

5. IPK ACD Plus prompts for the necessary input.

6. You will be asked to select which components of the IPK ACD
Plus to install.

Install all of the components:  Server, Monitor, Administration,
and the RTD Client Programs

OR

Install two Client components: Monitor and the Administration
Program

OR

Install Server application only

OR

Install Real Time Display Client Application only

7. After  a successful setup:
The ACD Plus Server icon appears in the Windows Startup
program group
The IPK ACD Plus Suite program group appears in the
Windows Program Manager

5.3 Setting the IP Configuration on the  ACD(8)-U30 ETU
ACD Plus can communicate with the ACD Plus MIS Server using
either a direct serial connection between the ACD(8)-U30 ETU and
the server PC, or by using the Ethernet port on the ACD(8)-U30
ETU. If the Ethernet port is being used, then the ACD(8)-U30 ETU
will need to be configured to communicate with the ACD Plus MIS
server across the IP network. ACD Plus will support using either
DHCP or a fixed IP address for the MIS server. The following
instructions describe how to set the IP configuration on the
ACD(8)-U30 ETU for the ACD Plus application.

5.3.1 Requirements
Host PC with available serial port
Serial cable
HyperTerminal
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5.3.2 Instructions

1. Connect the serial cable from the host PC to the serial
port on the ACD(8)-U30 ETU.

2. Open a HyperTerminal session for the serial port with
the following settings: (38K baud, 8/N/1).

3. On the ACD(8)-U30 ETU, set dipswitch #2 to ON and
dip switches #1, #3, and #4 to OFF.

4. Slide the RUN/SHUTDOWN switch on the ACD(8)-
U30 ETU  to SHUTDOWN, and wait for the Shutdown
LED to turn on, and then slide the switch back to RUN.

5. When the ACD(8)-U30 ETU reboots, HyperTerminal
will display the following messages:

6. Enter the following command to start the configuration
utility: setupip.
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The setup utility will display the current IP settings. If the
current settings specify DHCP, then the following
messages will be displayed. 

If the current settings specify a fixed IP address, then
messages similar to the following will be displayed.

7. To change the current settings, enter Y in response to
Change configuration? (Y/N) :.

8. If IP addresses are assigned on your network using
DHCP, then enter Y, in response to the prompt Use
DHCP? (Y/N) :.
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Proceed to step 11 to reset the ACD(8)-U30 ETU.

9. If the ACD(8)-U30 will need a fixed IP address, then
enter N, in response to the prompt Use DHCP? (Y/N) :

10. Enter the IP address, Subnet Mask address, and
Default Gateway address in response to the prompts.
The format for the IP, Subnet, and Default Gateway
addresses is (www.xxx.yyy.zzz), for example
192.168.144.011.

11. Reset the ACD(8)-U30 ETU by sliding the RUN/
SHUTDOWN switch to the SHUTDOWN position and
wait for the Shutdown LED to turn on. 

12. Set dipswitch #2 to the OFF position. 
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13. Connect the Ethernet cable to the Ethernet port on the
ACD(8)-U30 ETU.

14. Slide the RUN/SHUTDOWN switch to the RUN
position.

Start the ACD Plus MIS Server application.
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Logging Into Xen IPK
Plus Server Chapter 4

SE C T I O N 1
STARTING IPK ACD 
PLUS SERVER FOR 
THE FIRST TIME

To start IPK ACD Plus Server for the first time:

1. From the Windows Start menu, choose Programs.

2. Select IPK ACD Plus Suite, then choose ACD+ Server from the IPK
ACD Suite menu. 

The following Welcome display will appear:

3. From the Preferences Menu, select ACD Communications if the serial
port is not COM1 or if you are connecting via the LAN. COM1 is the
default. Refer to  1.2 Selecting the COM or LAN Port for the KSU on page
-25, if needed.

4. From the Preferences Menu, select Network if the network is NETBIOS.
TCP/IP is the default. Refer to Section 1.3 Selecting the Network
Preferences for the KSU on page -26, if needed.

5. Enter the username:  nec (default).

6. Enter the password:  password (default).

Figure 41:  Server Welcome Screen
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7. Click Continue to connect to the KSU/ACD.

If the username or password is entered incorrectly, a status message
will inform you that your entry is invalid. After entering both a correct
username and password, IPK ACD Plus Server completes
initialization and displays the real-time screen. 

It is recommended, but not required, to use the ADMIN program for
changing the default username and password.

The IPK ACD Suite setup program includes the IPK ACD Suite icon in
the Windows Startup program group. IPK ACD Plus Server
automatically starts each time you start Windows. For more information
about starting programs automatically from within Windows, refer to
your Microsoft Windows documentation.

1.1 Describing the IPK ACD Plus Server Welcome Screen 
Information
The Welcome window contains the following information:

Startup Date/Time
The Startup Date/Time box on the IPK ACD Plus Server
Welcome Window displays the current date and time from the
PC’s clock/calendar.

ACD Port Status
The ACD Port Status box displays the current status of the
PC’s serial port(s). OK indicates that the port is operational.

System Errors
The System Errors box displays an information message if
there are any system problems. If the system is functioning
properly, OK will appear as the status. The program uses pop-
up boxes to display various error messages about the system
(i.e. insufficient memory, hard disk full, etc.). These error
messages are recorded in a file named error.log. IPK ACD
Plus error messages are not displayed here.

 ACD Version
The ACD Version box displays the current version of the ACD
operating system.

Server Version
The Server Version box displays the current version of the IPK
ACD Plus Server software program.

UserName
The user name of the system is entered in this box. The default
username is nec (lowercase) until the system administrator
changes the user name in the Administration Program. After
entering a correct username and password, IPK ACD Plus
completes initialization and displays the real-time screen.
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Password
The program password is entered in this box. The default password
is password (lowercase) until the system administrator changes it in
the Administration Program. After entering a correct password and
username, IPK ACD Plus completes initialization and displays the
real-time screen.

1.2 Selecting the COM or LAN Port for the KSU

1. From the Preferences menu on the Server Welcome Window, select
ACD Communications. 

2. Select the COM port that connects to the KSU or the LAN if you are
using the network to make the connection. 

3. Click OK. 

Figure 4-2:  Port Selection Window Example
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1.3 Selecting the Network Preferences for the KSU

1. From the Preferences menu on the Server Welcome Window, select
Network.

2. The Network options are:
TCP/IP (default)
NETBIOS
NONE

3. Click OK.

SE C T I O N 2
UNDERSTANDING WHAT 
HAPPENS UPON 
STARTUP

The Server retrieves the configuration information (such as agent IDs and
queue configuration) from the KSU/ACD upon startup. The IPK ACD Plus
Monitor retrieves the status of all agents at startup and displays all current
information. If a call is in progress when the IPK ACD Plus Server starts, it is
displayed on the screen, but the statistics are ignored. IPK ACD Plus Server
may take as long as 30~45 seconds to establish a connection and begin
showing the real-time data. 

Figure 4-3:  Network Selection Window Example



Automatic Call Distribution (ACD) User Guide Chapter 5 – 27

D
oc

. N
o.

 8
31

0 
- R

el
ea

se
 1

.0
Ju

ne
 2

00
4

Configuring IPK ACD 
Plus Server Chapter 5

SE C T I O N 1
TOURING THE MAIN 
IPK ACD PLUS 
SERVER WINDOW

The IPK ACD Plus Server Window contains three menus (File, Preferences,
and Help) and a Queue Status panel. 

The IPK ACD Plus Server program is responsible for setting up
communication with the NEC KSU and recording call activity to an external
database. Statistics are stored in the database for historical reference. The
server should be left running at all times so that call records can be properly
stored. The server is capable of running in a foreground or background
window. The server application is added to the Startup tasks so that it will
auto-start when the PC is turned on. NEC recommends that the Server PC
be a  dedicated system reserved exclusively for IPK ACD Plus Server, IPK
ACD Plus Monitor, and IPK ACD Plus  Administration programs.

Once initiated, the program begins to accept data from the KSU in
approximately 30~45 seconds. 

Figure 5-1:  IPK ACD Plus Server Main Window
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1.1 Queue Status Panel
The Queue Status panel appears on the Main Screen Window. It
displays queue information for only those ACD groups that are
active. For instance, if there are two ACD groups assigned, then the
queue status panel displays only those two groups and the
associated information. The queue status panel is a fixed panel
that is sized relative to the active window and the number of active
ACD groups. 

The Queue Status panel shows three types of information for an
active ACD group.

1.1.1 Number of Active Agents
The # Active Agents row on the Queue Status panel gives
the number of agents logged into each ACD group (i.e. in
any status other than LOG OUT). The format is XX.

1.1.2 Number of Calls In Queue 
The Calls In Queue row on the Queue Status panel gives
the number of calls in queue for each ACD group. The
format is XXX.

1.1.3 Longest Hold Time
The Longest Hold Time row on the Queue Status panel
gives the longest time a caller has been on hold to speak to
an agent for each ACD group. The format is mm:ss/hh:mm.

SE C T I O N 2
FILE MENU 

The File Menu selections are listed in Figure 5-2: File Menu.

2.1 Restoring Last Administration Passwords
From the File menu, select Restore Last Admin Passwords.

2.2 Setting Passwords to Default
From the File menu, select Set Passwords to Default to set
passwords to their default values. Default username is nec and the
password is password.

Figure 5-2:  File Menu
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2.3 Set KSU Time
From the File menu, selecting Set KSU Time synchronises the ACD
processor time to the PC time.

2.4 Refresh ACD State
From the File menu, select Refresh ACD State to request fresh
state information from the ACD application. The new data is sent to
each open Monitor application.

2.5 Server Statistics
From the File menu, select Server Statistics. This selection allows
viewing of vital Server data.

2.6 Exiting IPK ACD Plus Server
From the File Menu, select Exit to close the Server application.

SE C T I O N 3
PREFERENCES MENU

The Preferences Menu includes three options: Thresholds,  Server
Wallboard, and RTD Clients. 

3.1 Setting Thresholds
Selecting Thresholds from the Preferences menu displays the User
Definable Thresholds screen. From this screen you can review or
define two different threshold settings for the following Real-Time
Display fields: 

Active Agents
Average Answer Time (sec.)
Average Idle Time (sec.)
Average Non ACD Time (sec.)
Average Time on Call (sec.)
Calls In Queue
Calls Abandoned
Calls Received
Longest Hold Time (sec.)

Figure 5-3:  Preferences Menu
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Number Non ACD Calls
Agent Break Time (sec.)
Agent Wrap Time (sec.)
Agent Call Time (sec.)

You can set the thresholds from IPK ACD Plus Server. However, you
will only see the colours responding on the main server window in
the Queue Status panel for the following items:

Active Agents
Calls In Queue
Longest Hold Time

A threshold’s configuration is valid for all ACD groups. IPK ACD Plus
Monitor requires that the second threshold is greater than the first
threshold (except for the Active Agents thresholds). You have the
option to configure either one or two thresholds. Keep in mind that if
you only configure one threshold, the application uses only one
threshold on the real-time display. 

Each field has two thresholds that you can assign a corresponding
colour from a Windows colour palette. The colour settings for these
two thresholds visually notifies an administrator of potential call
handling problems when viewing information from the main screen. 

For instance, meeting or exceeding the first threshold level changes
the background colour of the field to the assigned colour for that
threshold (i.e. Active Agents background colour changes from gray
to blue). Meeting or exceeding the second threshold level changes
the background colour of the field to the selected colour for that
threshold (i.e. Active Agents background colour changes from blue to
red). Refer to Figure 5-4: User-Definable Thresholds Window for an
example of this window.
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To set the Threshold Configuration:

1. From the Preferences Menu, select Thresholds. Refer to
Figure 5-3: Preferences Menu.

2. Uncheck the Off box.

3. Click a text entry box.

4. Enter a valid number. Valid threshold levels are all positive
integers as well as zero and OFF (OFF is the default setting).
If you make an invalid entry, the application displays a error
message and gives you the correct format for that entry.

5. Double-click a text entry box.

6. Make a colour selection. The default threshold colours are
yellow for Colour Threshold 1 and red for Colour Threshold  2.
Notice that after you select a colour, the background of the
text entry box displays the selected colour. 

7. Continue steps 2 through 6 as needed.

8. Click OK.

Figure 5-4:  User-Definable Thresholds Window
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3.2 Setting Wallboard Options
When you are setting the wallboard options, you will choose the type
of signs that are on your network (either one or two-line signs).

You can daisy-chain wallboards. If you daisy-chain wallboards, each
sign will display the same data because you cannot mix a two line
and a one line sign on the same RS-485 network.

To set wallboard options:

1. From the Preferences menu, select Server Wallboard.

2. Select one of the following types of signs:
NONE
One Line
Two Line

3. Select the COM Port to which the wallboard is connected.
Refer to Figure 5-5: Wallboard Options for an example of this
window.

4. Click OK.

Figure 5-5:  Wallboard Options
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3.3 Clearing Wallboard Memory
If the sign is not working correctly or you receive unusual messages,
you can clear the sign’s memory.

To clear the wallboard memory:

1. From the Preferences menu, select Server Wallboard.

2. Click the Sign Clear button.

3. Click OK.

Figure 5-6:  Clearing Sign Memory
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3.4 Setting RTD Client Privileges
The Real Time Display (RTD) is a client application that provides
real-time queue statistics to the agent desktop. By installing the RTD
Client software on an agent PC, the agent can monitor the status of
individual ACD queues and help control the overall efficiency of the
call center.

The ACD Plus Server controls which agents are allowed to use the
RTD Client software and which features are available to each client.
To set the RTD Client privileges, select the RTD Clients option from
the Preferences menu. 

This menu lists all of the agents that are currently defined within the
ACD. An indicator next to each agent name designates if the agent is
currently running RTD Client software and connected to the ACD
Plus Server. A green indicator signifies that the agent is currently
using the RTD software.

The other three columns in the menu control the privileges that each
agent has when using the RTD Client software. A check in a column
indicates that the agent has been given the specific privileges.

Authorised Client - a check in this column indicates that the
agent is allowed to use the RTD Client software. If an agent
that is not authorised attempts to login using the RTD Client
software, they will receive an error message and the client
application will be terminated.
Active Queues - by default, the RTD Client displays all
queues to which an agent is assigned, as defined within the
ACD Plus Admin configuration. By checking the Active Queues
option, the RTD Client will only display the queues that an
agent is actively logged into.

Figure 5-7:  RTD Client Configuration
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Text Messaging - the RTD Client has a feature that allows a
user to sent text messages to other RTD clients. If this column
in not checked, then the Message feature is disabled on the
options menu for the specific agent.

3.5 Obtaining Server and System Information
To obtain information about the IPK ACD Plus Server and
system information:

1. From the Help menu, select About Server.

2. Click System Info button.

3. Click OK.

Figure 5-8:  IPK ACD Plus Server Help Menu

Figure 5-9:  About IPK ACD Plus Server Window
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Learning About IPK 
ACD Plus Monitor Chapter 6

SE C T I O N 1
STARTING IPK ACD 
PLUS MONITOR FOR 
THE FIRST TIME

To start IPK ACD Plus Monitor for the first time:

1. From the Windows Start menu, choose Programs.

2. Select ACD+ Monitor from the IPK ACD Plus Suite menu.

3. No password is requested. However, if you are running IPK ACD Plus
Monitor on a remote PC, you will need the IP (Internet Protocol)
address or machine name of the server PC. See the network
administrator if the server’s IP address (or name) can not be
determined.

4. Click Connect.

SE C T I O N 2
EXITING IPK ACD PLUS 
MONITOR

To exit IPK ACD Plus Monitor:

From the IPK ACD Plus Monitor’s File menu, select Exit.

OR

Click the Close button in upper right-hand corner of the IPK ACD Plus
Monitor window.

Figure 6-1:  Monitor Login Screen
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SE C T I O N 3
DESCRIBING THE MAIN 
SCREEN

After entering a valid server name, the IPK ACD Plus Monitor main screen
appears on the monitor. This screen consists of a menu bar and five panels
containing information. 

3.1 Panels
The screen divides information into the following five panels.

3.1.1 Agents Panel
The Agents panel shows the current status of every group/
agent tracked by the IPK ACD Plus Monitor program. 

The agents’ information appears for up to four ACD groups.
Each group displays the agent’s ID, status, and time. The
maximum number of agents/supervisors is 108. 

Each group has its own window. You can navigate within
each group via scroll bars (vertical and horizontal) using
the mouse.

The Agent panel of the real-time display shows all
programmed groups and all agents within each group. This
panel appears in the upper left portion of the IPK ACD Plus
Monitor window. Agents are listed by the way that the IDs
were assigned in the Agent and Supervisor’s ID tabs. 

Figure 6-2:  IPK ACD Plus Monitor Main Screen



Xen IPK Automatic Call Distribution (ACD) User Guide

Automatic Call Distribution (ACD) User Guide Chapter 6 – 39

D
oc

. N
o.

 8
31

0 
- R

el
ea

se
 1

.0
Ju

ne
 2

00
4

Only those groups that are “active” displays in the panel.
For instance, if only two groups are utilised, the agent
panel displays two group windows instead of the maximum
total of four group windows.

The Agent Panel gives information about each agent in the
following three columns on the Agent Panel.

Agent Column

The Agent column is the text ID given (in IPK ACD Plus
Admin MIS configuration) to an agent. 

This field is a maximum of 10 characters in length.

State Column

The State column gives the current status of that agent. 

The following table lists the status codes.

Figure 6-3:  Agent Panel
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Each status code is assigned a specific background colour
for easy recognition. The background for each agent status
is defined in the Preference-Agent Colours menu.

When starting IPK ACD Plus Monitor, each agent has a NO
STAT status until the agent’s status changes. 

Length Column
The Length Column contains the length of time that each
agent has been in the current status. The time format is
mm:ss/hh:mm.

Table 6-1:  Agent Status Code Descriptions

Status Description

NO STAT The NO STAT status code indicates that no 
data has been received for that agent since  
starting IPK ACD Plus Monitor. 

BREAK The BREAK status code indicates that the 
agent is in Break mode. While in Break mode, 
the agent will not receive any ACD calls.

WRAP The WRAP status code indicates that the agent 
is in Wrap mode. While in WRAP mode, the 
agent will not receive any ACD calls.

IDLE The IDLE status code indicates that the agent is 
logged in and available to take an ACD call.

LOG OUT The LOG OUT status code indicates that the 
agent is logged out of IPK ACD Plus.

ACD CALL The ACD CALL status code indicates that the 
Agent is on an ACD call.

NON ACD The NON ACD status code indicates that the 
agent is on a NON ACD call.

RING The RING status code indicates that the ACD 
call is ringing for the agent.

OTHER The OTHER status code indicates that the 
agent is servicing another group.
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3.1 Viewing Agent Statistics for the Day

To view Agent statistics for the day:

1. Double click anywhere in the Agent Panel area of the main
screen.

2. A dialogue box is presented that contains a list of each
available agent. Select an agent and press the GET DATA
button to retrieve detailed information for each agent.

  

3. The statistics provides the following information about the
agent:

• Current status

• Total time logged in for each active group

• Number of ACD calls for each active group

• Average ACD call length for each active group

• Average Non ACD time (time on a call, but not an ACD
call)

• Average BREAK length (average time spent in BREAK
mode)

• Average WRAP length (average time spent in WRAP
mode)

• Total Call Length for each active group

Non ACD calls less than 10 seconds in length do not
appear in the statistics.

4. Click the CLOSE button to exit to the main screen, or click on
PRINT to print out an agent data page. The print button uses

Figure 6-4:  Agent Detail Screen
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the Windows default printer.

3.1.1 Real-Time Graph Panel
The Real-Time Graph panel displays in the upper right
corner. It updates, in real-time, a graph of the end-user’s
choice. The Real-Time Graph appears in graphical (bar
chart) format. The size of this panel is relative to the size of
the main window.

Refer to 7.1 Selecting a Real-Time Graph to Display on the
Main Screen on page -53 for more information. 

3.1.2 Queue Status Panel
The Queue Status panel is another section of the Monitor
main screen. It displays queue information for only those
ACD groups that are active. For example, if there are two
ACD groups assigned, then the queue status panel
displays only those two groups and the associated
information. The queue status panel is a fixed panel that is
sized relative to the real-time display and the number of
active ACD groups. 

The Queue Status panel shows three types of information
for an active ACD group.

Figure 6-5:  View of Real-Time Graph Panel

Figure 6-6:  View of the Queue Status Panel
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Number of Active Agents
The # Active row on the Queue Status panel gives the
number of agents logged into each ACD group (i.e., in any
status other than LOG OUT). The format is XX.

Number of Calls In Queue 
The Calls In Queue row on the Queue Status panel gives
the number of calls in queue for each ACD group. The
format is XXX.

Longest Hold Time
The Longest Hold Time on the Queue Status panel gives
the longest time a caller has been on hold to speak to an
agent for each ACD group. The time format is mm:ss/
hh:mm.

3.1.3 Task Summary Panel
The Task Summary panel displays summary information
for all active ACD groups for the selected period which you
specify. Refer to 6.2 Setting the Statistics Period for the Task
Summary Panel on page -50 for more information on setting
the statistics period. Only those ACD groups that are
utilised appear in the task summary panel. The panel
appears in the lower right corner of the IPK ACD Plus
Monitor screen. 

The Task Summary panel contains the following four
rows of information per active ACD group during the
selected period:

Calls
The Calls row gives the number of calls received by that
ACD group during the selected period. The system
considers a call received once the call reaches the ACD
group (i.e. rings on an agent set, ACD greeting is played,
etc.) or queue. The calls received number format = XX.

Average Call Time
The Avg Call Time row gives the average time for the
selected period that agents spend per ACD call per ACD
group. Format = mm:ss/hh:mm.

Figure 6-7:  Task Summary Panel
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Average Answer Time
The Avg Answer Time row gives the average time for the
selected period (including ring time) that callers spent in
queue before speaking to an agent. 

Format = mm:ss/hh:ss.

Calls Abandon
The Calls Abandon row gives the number of callers that
hung up prior to being connected to an agent during the
selected period. The calls abandoned number format = XX.

3.1.4 Status Bar Panel
The Status Bar Panel is another section of the Monitor
main screen. It shows a summary of information for all the
queues combined for the selected period that is specified.
Refer to 6.2 Setting the Statistics Period for the Task Summary
Panel on page -50. The panel appears on the bottom of the
Monitor main screen.

The Status Bar Panel displays three types of information:

Idle Agent
Idle Agent (#/avg) shows the total number of agents that
were idle and the average time they were idle for the
selected period. If an agent was idle and then takes an
ACD call and then goes back idle, that will show up as two
total idle agents. Format = XXX/(mm:ss/hh:mm).

Number NONACD Calls
NUM NONACD CALL shows the total number of Non-ACD
calls for the selected period. Non-ACD calls less than 10
seconds in length do not appear in the statistics. Format =
XXX.

Average NONACD Time
AVG NONACD TIME shows the average time on Non-ACD
calls for the selected period. Non-ACD calls less than 10
seconds in length do not appear in the statistics. Format =
mm:ss/hh:mm.
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SE C T I O N 4
ACCESSING A MENU

To a display a menu, either click on the menu name or while holding down
Alt, press the underlined letter of the menu name.

4.1 Getting Help
The IPK ACD Plus Monitor program provides on-line help through a
comprehensive menu. 

You can access help information by selecting Monitor Help from the
Help Menu. Refer to Figure 6-8: Help Menu for an example of this
window. 

4.1 File Menu
The File menu contains the following items for selection. 

4.1.1 Synchronizing Time with the Server
From the File Menu, select TimeSync w/Server. 

If on same PC as the Server, the option is grayed out. On
Remote PC, time on the PC is changed to time on Server
PC.

4.1.2 Exiting IPK ACD Plus Monitor
From the File Menu, select Exit to close the application.

Figure 6-8:  Help Menu

Figure 6-9:  File Menu
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SE C T I O N 5
SETTING THE 
THRESHOLD 
CONFIGURATION

Selecting Threshold Configuration from the Preferences menu displays the
User Definable Thresholds screen. From this screen you can review or
define two different threshold settings for the following Real-Time Display
fields.

Active Agents

Average Answer Time (sec.)

Average Idle Time (sec.)
Average Non ACD Time (sec.)

Average Time on Call (sec.)

Calls in Queue
Calls Abandoned

Calls Received

Longest Hold Time (sec.)
Number Non ACD Calls

Agent Break Time (sec.)

Agent Wrap Time (sec.)
Agent Call Time (sec.)

A threshold’s configuration is valid for all ACD groups. IPK ACD Plus
Monitor requires that the second threshold is greater than the first threshold
(except for the Active Agents thresholds). You have the option to configure
either one or two thresholds. Keep in mind that if you only configure one
threshold, the application uses only one threshold on the real-time display.

Each field has two thresholds that you can assign a corresponding colour
from a Windows colour palette. The colour settings for these two thresholds
visually notifies an administrator of potential call handling problems when
viewing information from the main screen.

The Off box must be deselected before any changes to a threshold can be
made.

For example, meeting or exceeding the first threshold level changes the
background colour of the field to the assigned colour for that threshold (i.e.,
Active Agents background colour changes from gray to blue). Meeting or
exceeding the second threshold level changes the background colour of the
field to the selected colour for that threshold (i.e., Active Agents background
colour changes from blue to red).
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To Set the Threshold Configuration:

1. From the Preferences Menu, select Threshold Configuration.

The Off box must be deselected before any change to a threshold can
be made.

2. Click on a text entry box.

3. Enter a valid number. Valid threshold levels are all positive integers,
as well as zero and OFF (OFF is the default setting). If an invalid entry
is made, the application displays an error message and gives the
correct format for that entry.

4. Double-click a text entry box.

5. Make a colour selection. The default threshold colours are yellow for
Colour Threshold 1 and red for Colour Threshold 2. Notice that after
you select a colour, the background of the text entry box displays the
selected colour. 

6. Continue steps 2 through 5, as needed.

7. Click OK.

Figure 6-10:  User-Definable Thresholds Window
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SE C T I O N 6
SETTING WALLBOARD 
PREFERENCES

Selecting the Wallboard option from the Preferences menu allows you to
select the wallboard functions according to your requirements. 

There must be an available COM port for this option before you can select
the Wallboard. If a COM port is not available, the Wallboard option is grayed
out if it is on the same PC as the server, the wallboard settings will not take
affect if changed in the monitor application. 

To set the Wallboard Preferences:

1. From the Preferences Menu, select Wallboard.

2. Set the Wallboard options, as needed. The COM port must be
selected, as well as whether a one-line, two-line, or no sign support is
needed.

3. Click OK.

Figure 6-11:  COM Default is Invalid Message

Figure 6-12:  Wallboard Options
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6.1 Agent Status Code Colours
Selecting the Agent Colours option from the Preferences menu
displays the Agent Colour definitions window. 

From this window the Agents’ colours are defined for the following
ACD states:

NOSTAT- When status is not known

BREAK- Agent on break

WRAP- Agent in Wrap-up mode

IDLE- Agent ready to receive task

LOGOUT- Agent is logged out

ACD CALL- Agent on ACD call

NONACD- Agent on NONACD call

RING- Agent phone ringing (ACD)

OTHER- Agent is servicing another group

Figure 6-13:  Agent Colour Selection Window
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6.2 Setting the Statistics Period for the Task Summary Panel
Selecting the Statistics Period option from the Preferences menu
allows you to set the period of time used to calculate information in
the Task Summary Panel on the real-time display. The statistics
period is valid for all groups. Setting the statistics period has no effect
on storing or displaying historical information.

The Statistics Period screen provides six options: 

15 minutes
1 hour
4 hours
8 hours
12 hours
24 hours 

You can also select the start time for the first period. The default
statistics period is one hour. Refer to Figure 6-14: Statistics Period
Window for an example of this screen.

 

Figure 6-14:  Statistics Period Window
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To set the Statistics Period for the Task Summary panel:

1. From the Preferences Menu, select Statistics Period.

2. Select the amount of time used to calculate information in the Task
Summary Panel. The time options are: 

15 minutes
1 hour
4 hours
8 hours
12 hours
24 hours

If 15 minutes, 1 hour, or 24 hours is selected, a start time will not
have to be selected for the period. However, for the 4, 8, or 12
hour settings, a start time can be selected to begin. This provides
maximum flexibility in deciding which periods are to be displayed
in the Task Summary area.

3. Click OK. 

6.1 Changing the Font Setting
Selecting the Font option from the Preferences menu displays the
Font screen. From the Font screen you can configure the following
elements for your printed reports and on-screen statistics:

Font Type
Font Style
Font Size

It may be necessary to change the fonts when the size of the main
form is changed. For example, some people like their windows as
large as possible. If the Monitor screen is maximised, the font does
not automatically enlarge. Changing the font from the Preferences
menu allows choosing the right font type and size for proper viewing.
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To change the Font setting for the screen display:

1. From the Preferences Menu, select Font.

2. Change the following options as needed.

Font Type
Click the name of the font that you would like to use for your
reports. A sample of how the font will look appears in the Sample
box.

Font Style
Choose one of the following formats for the font type:

•  Regular

•  Italic

•  Bold

•  Bold Italic

Font Size
Choose one of the available font sizes.

Figure 6-15:  Font Window
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SE C T I O N 7
REAL-TIME GRAPH 
MENU

7.1 Selecting a Real-Time Graph to Display on the Main 
Screen
You can select which graph displays in the real-time graph panel on
the main screen for a specific group from the Real-Time Graph
Menu. The Real-Time Graph displays data for only one group. The
Group option provides a pull down menu with Group 1 through
Group 4 as the options. 

To set your report times, choose the Set Times option. Refer to
Figure 6-16: Real-Time Graph Menu  for an example of this window. 

To Select a Real-Time Graph to Display on the Main Screen:

1. From the Main screen, select Real-Time Graph.

2. Select the graph that you would like to display. 
The options are:

NONE

If NONE is selected, the Real-Time Display is removed. 

Agent Stats - Time Log
Agent Stats - Call Processing
Agent Stats - ACD Traffic (hour)
Group Stats - Call Processing
Group Stats - ACD Traffic
Group Stats - Call Traffic (hour)
Call Abandon Time
Group Stats - Call Processing (hour)

3. Click OK.

Figure 6-16:  Real-Time Graph Menu
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7.1 Reviewing System Information and Version
To review System Information:

1. From the Help Menu, select About Monitor.

2. If you wish to return to the Main Window, Click OK.
OR
If you want to review the System Information, click System Info.
Close the window when done. 
Refer to the Microsoft Windows documentation regarding more
information about the System Information window.

Figure 6-17:  About IPK ACD Plus Monitor Screen
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IPK ACD Plus
Monitor Reports Chapter 7

SE C T I O N 1
ENTERING THE IPK 
ACD PLUS REPORTS 
WINDOW

To enter the IPK ACD Plus Reports window:

1. From the main screen, select the Reports menu. 

2. Choose from the following selections:

Agent Detail
Selecting this works the same way as double-clicking in the agent
area of the screen. This will display an agent detail dialogue box.

Enter Reports Screen
Enters the Reports screen selections.

Auto Print
Sets the automatic print options.

Force Auto Print Now
Setting this forces the selected autoprint reports to print now,
instead of their preselected time.

3. From the Reports menu, select Enter Reports Screen.

The IPK ACD Plus Reports window allows configuring and viewing
report data.

Figure 7-1:  Reports Menu



June 2004 NEC Business Solutions Ltd

56 – Chapter 7 IPK ACD Plus Monitor Reports

D
oc

. N
o.

 8
31

0 
- R

el
ea

se
 1

.0
Ju

ne
 2

00
4

SE C T I O N 2
SELECTING A DATE 
RANGE FOR REPORTS

Choosing the Set Dates option from the ACD Reports’ Preferences Menu
allows for entering the date range for the data retrieval by selecting a start
date and an end date. 

The default reporting period is the last period selected. For instance, if the
last start date was 5/20/00 and the end date 5/23/00, the default reporting
period starts on 5/20/00 and ends on 5/23/00. The default dates remain until
you alter either the start date or end date. If no one has ever selected a date
range, the default start and end date is the day that Monitor was installed.

To select a Date Range for reports:

1. From the Main Screen, select the Reports menu.

2. From the Reports menu, select Enter Reports Screen.

3. From the Preferences menu, choose the Set Dates option.

Figure 7-2:  Configuring and Viewing Report Data

Figure 7-3:  Preferences Menu - ACD Reports Window
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4. Set a date range for the reports by performing one of the following:

Click a Start Date, then an Stop Date from the calendars.

OR

Click one of the following buttons:

•Today Only
•This Week
•This Month
•This Year

Refer to Figure 7-4:, Select Date Range for Reports Window on page 57
for an example of this window.

If you set the Start Date to be greater than the Stop Date, it will
change the Stop Date to be equal to the Start Date. Also, if you set the
Stop Date to be less than the Start Date, it will change the Start Date
to be equal to the Stop Date.

5. Click OK.

Figure 7-4:  Select Date Range for Reports Window
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2.1 Setting Times for “By Hour” Reports
Choosing the Set Times option from either the Real-Time Graph
Menu or the ACD Reports Preferences Menu allows for changing the
hours on only the “By Hour” reports. 

2.2 Selecting a Group for the Real-Time Graph
Choosing the Set Group option from either the Real-Time Graph
menu or the ACD Reports Preferences menu allows for selecting
which group to view.

To select a group for the Real-Time Graph:

1. From the Main Screen, select the Reports menu.

2. From the Reports menu, select Enter Reports Screen.

3. From the Preferences menu, select Set Group.

4. Choose a group for the Real-Time Graph. 

Figure 7-5:  Time Span “By Hour” Reports Screen

Figure 7-6:  Real-Time Graph Group Selection
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2.3 Formatting the Real-Time Display
Choosing the Format option from the ACD Reports Preferences
menu allows for selection of one of the following report styles.

Text Only
Chart Only
Both Text and Chart

To select the Real-Time Display format:

1. From the Main screen, select the Reports menu.

2. From the Reports menu, select Enter Reports Screen.

3. From the Preferences menu, choose Format.

4. Check one of the following:

Text Only

Chart Only

Both Text and Chart

Figure 7-7:  Real-Time Display - Format Options
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2.4 Selecting a New Report 

To select a New Report: 

1. From the Main Screen, select the Reports menu.

2. From the Reports menu, select Enter Reports Screen. 

3. From the New Report menu, choose a report. 

After selecting a report from the Reports menu, the screen displays
the report in text mode or chart mode for a specified group during
the user-defined period. 
The type of mode that appears (text or chart) depends upon the
style of report that you select from the Format menu. The report
gives information about the group you select from the Group menu.
The time scale format changes from mm:ss to hh:mm if the number
is greater than 60 minutes. The number format for the number of
calls is XXX.
IPK ACD Plus Monitor considers a call “abandoned” if the caller
disconnects before the caller speaks with an ACD agent.
There are two types of abandoned calls:

Queue Abandoned Calls
The number of callers that hang up before reaching the ACD group.

Agent Abandoned Calls
The number of callers that reach the ACD group (Call Received -
Agent Ringing) but hang up before speaking with an agent.

Calls that overflow are considered as abandoned calls, because
they left the queue without speaking to an agent.

Figure 7-8:  Reports Menu

Figure 7-9:  New Report Menu - ACD Reports Window
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The screen displays readable fonts for the report. The report
window contains scroll bars. These scroll bars allow you to scroll
left, right, up, or down to view information that does not fit on the
screen.
The reports, and the information included for each report, are listed
next. Refer to 2.5 Describing the Reports on page -62. 

 

Figure 7-10:  Example of Displaying Report (Chart Only)

Figure 7-11:  Example of Displaying Report (Text Only)
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2.5 Describing the Reports
IPK ACD Plus Monitor provides several reports.

Agent Stats - Time Log
Agent Stats - Call Processing
Agent Stats - ACD Traffic (Hour)
Group Stats - Call Processing
Group Stats - ACD Traffic
Group Stats - Call Traffic (Hour)
Call Abandon Time
Group Stats - Call Processing (Hour)

Each type of Real-Time Report is described in detail on the following
pages.

Call Abandon Time Report
The Call Abandon Time report displays either in text mode or chart
mode depending upon which style is selected from the Format menu. 

Call Abandon Times Report (Text Mode) report includes the
following information for every active group during each hour of the
user-defined period:

# Calls Abandoned 
Average time to abandon 
(Format = mm:ss/hh:mm)
Longest wait
Hours

This report displays the average time a caller waits before
abandoning a call. If callers consistently abandon calls during the
same time period each day, the department may need more
resources to answer calls during those time periods.
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Agent Stats - Call Processing Report
The Agent Stats - Call  Processing report displays either in text
mode or chart mode depending upon which style is selected from the
Format menu.

In text mode, this report includes the following information for each
agent in the specified group during the user-defined period:

Agent ID
Number of ACD calls
Average time spent on ACD calls 
(Format = mm:ss/hh:mm)
Number of time in Wrap
Average time spent in Wrap mode 
(Format = mm:ss/hh:mm)
Number of Non-ACD calls
Average time spent in Non-ACD calls  
(Format = mm:ss/hh:mm)   
Number of times in Break
Average time spent in Break
(Format = mm:ss/hh/mm)

Non-ACD calls less than 10 seconds in length do not appear in
the statistics.

Figure 7-12:  Call Abandon Time Report (Chart/Text)
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Agent Stats - ACD Traffic by Hour Report
The Agent Stats - ACD Traffic by Hour report displays either in text
mode or chart mode depending upon which style is selected from the
Format menu.

In text mode, this report includes the following information for each
agent in the specified group during the user-defined period:

Agent ID
Hours
Number of ACD Calls Answered

    

Figure 7-13:  Agent Stats - Call Processing Report (Chart/Text Mode)

Figure 7-14:  Agent Stats - ACD Traffic by Hour Report (Chart/Text Mode)
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Agent Stats - Time Log Report
The Agent Stats - Time Log report displays either in text mode or
chart mode depending upon which style is selected from the Format
menu. 

This report includes the following information for each agent in the
specified group during the user-defined period:

Agent ID 
Logged-in time (Format = mm:ss/hh:mm)
Idle time (Format = mm:ss/hh:mm)
Time spent in Break mode 
(Format = mm:ss/hh:mm)
Wrap up time (Format = mm:ss/hh:mm)
Time spent on ACD calls 
(Format = mm:ss/hh:mm)
Time spent on NONACD calls 
(Format = mm:ss/hh:mm)
Number of ACD calls (text mode only) (Format = XXX)
Number of NONACD calls (text mode only) (Format = XXX)

NONACD calls less than 10 seconds in length do not appear in
the statistics.

 

Figure 7-15:  Agent Stats - Time Log Report (Chart/Text Mode)
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Group Stats - Call Processing Report
The Group Stats - Call  Processing report displays either in text
mode or chart mode depending upon which style is selected from the
Format menu. 

In text mode, this report includes the following information for every
active group during the user-defined period:

Group ID
Number of ACD calls
Average ACD Time
Number of Calls Queued*
(Format = mm:ss/hh:mm)
*Calls Queued are calls that had to wait (played an ACD Message)
before being transferred to an available agent.

Average Hold Time (Format = mm:ss/hh:mm) 
Wrap Count
Average Wrap Time
(Format = mm:ss/hh:mm)
Number of Non-ACD Calls
Average Non-ACD Time
(Format = mm:ss/hh:mm)
Break Count
Average Break Time
(Format = mm:ss/hh:mm)
Longest Wait (Format = mm:ss/hh:mm)

Non-ACD calls less than 10 seconds in length do not appear in
the statistics.

  

Figure 7-16:  Group Stats - Call Processing Report (Chart/Text Mode)
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Group Stats - ACD Traffic Report
The Group Stats - ACD Traffic report displays either in text mode or
chart mode depending upon which style is selected from the Format
menu. 

In text mode, this  report includes the following information for every
active group during the user-defined period:

Group ID
Number of Calls Answered
Number of Abandoned Calls
Number of Calls Queued*
*Calls Queued are calls that had to wait (played an ACD Message)
before being transferred to an availble agent.

Number of Calls Overflowed
  

Group Stats - Call Traffic by Hour Report
The Group Stats - Call Traffic by Hour report displays either in text
mode or chart mode depending upon which style is selected from the
Format menu.

In text mode, this report includes the following information for the
specified group during each hour of the user-defined period:

Hours
Calls Answered
Calls Abandoned
Calls Queued*
*Calls Queued are calls that had to wait (played an ACD Message)
before being transferred to an availble agent.

Calls Overflowed

Figure 7-17:  Group Stats - ACD Traffic Report (Chart/Text Mode)
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Group Stats - Call Processing by Hour Report
The Group Stats - Call Processing by Hour report displays either in
text mode or chart mode depending upon which style is selected
from the Format menu.

In text mode this report includes the following information for the
specified group during each hour of the user-defined period:

Hours
Average time spent on ACD calls 
(Format = mm:ss/hh:mm)
Average Hold Time
(Format = mm:ss/hh:mm)
Average time to Abandon 
(Format = mm:ss/hh:mm)
Longest Wait
(Format = mm:ss/hh:mm)

Figure 7-18:  Group Stats - Call Traffic by Hour Report (Chart/Text Mode)
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SE C T I O N 3
EXITING FROM THE ACD 
REPORTS WINDOW

To exit from the ACD Reports Window and return to the main window:

From the ACD Reports Window’s File Menu, select Exit to Monitor or
double-click on the close window button.

Figure 7-19:  Group Stats - Call Processing by Hour Report (Chart/Text Mode)

Figure 7-20:  File Menu - Exit to Monitor 
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IPK ACD Plus Terminal 
Interface Chapter 8

SE C T I O N 1
TERMINAL INTERFACE

This chapter describes the IPK ACD Plus Terminal Interface for agent and
the supervisor terminals. IPK ACD Plus allows any Xen IPK terminal with an
LCD display to function as either an agent or supervisor terminal, if it is
identified in the Administration Program. 

An agent becomes part of the ACD group by dialling the ACD port pilot
number from an Xen IPK terminal. IPK ACD Plus will answer a login request
only for terminals that are defined in the Administration Program. IPK ACD
Plus requests the user’s ID and password (defined in the Administration
Program) then grants that person access to their appropriate queue(s).
Agents can log into more than one queue at a time. 

IPK ACD Plus controls the LCD area on the terminal and assigns menu
options to the softkeys (SK). Softkeys are physically located below the
LCD area. The actual buttons on the terminal are not labelled. Although,
the instructions for completing terminal tasks reference the softkey numbers
with each LCD option for optimum clarification. The remainder of
this chapter provides visual examples of how the softkeys are referenced in
this manual. 

Figure 8-1:  Terminal Softkeys (SK)
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1.1 Logging into IPK ACD Plus Terminal Interface

To log into IPK ACD Plus Terminal Interface:

1. Dial the ACD Plus port pilot number.

2. Enter your ID.

3. Press OK.     

If you entered an invalid ID, the following prompt will appear for five
seconds, then the initial ENTER ID prompt will appear again.

4. Enter the password. The password can be up to eight characters in
length and may consist of any digit (0~9), the J key, and the L
key.

The password is defined in the IPK ACD Plus Administration
program. 

5. Press OK.

Figure 8-2:  Enter ID Prompt

CLEAR Pressing SK 1 (CLEAR) clears any digits that are 
entered.

OK After a valid ID is entered, pressing SK 4 (OK) 
gives a prompt for entering a password.

EXIT Pressing the EXIT button returns the terminal to 
standard Xen IPK operation.

Figure 8-3:  Invalid ID Screen
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If you entered an invalid password, the following prompt will appear
for five seconds then the initial ENTER PASSWORD prompt will
appear again. 

SUPERVISORS: If your ID has supervisor’s rights, IPK ACD Plus will
display the ‘LOG ON AS AGENT’ prompt at which time press SK 3
(YES) to log in as an agent or SK 4 (NO) to log in as a supervisor.
Refer to Figure 8-6: Log on as an Agent Prompt for Supervisor on
page 8-74.. 

Figure 8-4:  Enter Password Prompt

CLEAR Pressing SK 1 (CLEAR) clears any digits that you 
have entered. 

OK After you enter a valid password, pressing SK 4 
(OK) will begin agent operation if you are assigned 
to only one group. If you are assigned to more than 
one group, the ‘Select Groups’ prompt will appear. 
At that time, you will need to supply the groups that 
you wish to join.

EXIT Pressing the EXIT button returns the terminal to 
standard Xen IPK operation. 

Figure 8-5:  Invalid Password Display
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Logging On As Agent:
If you are assigned to only one group, after you enter a valid ID and
password, you are logged into IPK ACD Plus as an agent.

OR
If you participate in more than one group, after you enter a valid ID
and password, the display prompts you to enter the ACD group(s)
that you want to join. Continue with step 6.

6. Enter a valid group number or numbers (1~4) using the telephone
dialling pad for the group(s) you would like to join. 

  

Figure 8-6:  Log on as an Agent Prompt for Supervisor

Figure 8-7:  Select ACD Groups to Join



Xen IPK Automatic Call Distribution (ACD) User Guide

Automatic Call Distribution (ACD) User Guide Chapter 8 – 75

D
oc

. N
o.

 8
31

0 
- R

el
ea

se
 1

.0
Ju

ne
 2

00
4

7. Press OK. 
If you have entered valid group number(s), you are logged into IPK
ACD Plus.
If you entered an invalid group number, the following prompt will
appear for five seconds then the initial SELECT GROUPS prompt
will appear again. 

1.2 Agent Terminal after Logging In 
Once you have successfully logged into IPK ACD Plus as an Agent,
IPK ACD Plus displays the following on your terminal LCD. 

CLEAR Pressing SK 1 (CLEAR) clears any 
digits that you have entered. 

OK After you enter a valid group number or 
numbers (1~4), pressing SK 4 (OK) will 
begin agent operation in the ACD 
Groups selected.

EXIT Pressing the EXIT button returns the 
terminal to standard Xen IPK operation. 

Figure 8-8:  Invalid Group

Figure 8-9:  Agent Terminal LCD when Logged In
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1.3 Supervisor Terminal After Successfully Logging Into IPK
ACD Plus
Once you have successfully logged into IPK ACD Plus, IPK ACD
Plus displays the following on your terminal LCD. 

SE C T I O N 2
AGENT TERMINAL 
INTERFACE 

2.1 Break Mode
While in Break Mode, the terminal will not receive any ACD calls but
the terminal will continue standard (non-ACD) operation. IPK ACD
Plus will continue to monitor the agent’s terminal for softkey
messages and will generate call records for non-ACD calls. 

2.1.1 Placing Terminal in Break Mode

To place terminal in Break Mode:
Press SK 2 (BREAK). IPK ACD Plus places the terminal in
Break Mode and changes the LCD. Refer to Figure 8-11:
Agent Terminal in Break Mode on page 8-76.. 

2.1.2 Exiting Break Mode

To exit Break Mode:

Press SK 2 (BREAK-OFF). The terminal will resume
normal IPK ACD Plus operation.

Figure 8-10:  Supervisor Terminal LCD when Logged In

Figure 8-11:  Agent Terminal in Break Mode
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2.2 Wrap Mode
While in Wrap Mode, IPK ACD Plus will continue to monitor the
agent’s terminal for softkey messages and will generate call records
for non-ACD calls.

2.2.1 Placing Terminal in Wrap Mode

To place the terminal in Wrap Mode:
Press SK 3 (WRAP). IPK ACD Plus places the terminal in
Wrap Mode and changes the LCD. Refer to Figure 8-12:
Agent Terminal in Wrap Mode on page 8-77.. 

2.2.2 Exiting Wrap Mode

To exit Wrap Mode:
Press SK 3 (WRAPOFF). The terminal will resume normal
IPK ACD Plus operation.

Figure 8-12:  Agent Terminal in Wrap Mode
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SE C T I O N 3
QUEUE STATISTICS

The following statistics will appear on the terminal LCD for each queue that
you are a member of:

Name of the ACD queue

Number of agents logged in
Number of callers in queue (on hold)

Length of time that longest caller has spent in queue (minutes:seconds)

3.1 Displaying Queue Statistics

To display queue statistics:
Press SK 4 (STATS). IPK ACD Plus will display the queue statistics.
If you are a member of more than one queue, IPK ACD Plus will
display the statistics of each queue for five seconds each. The
terminal’s LCD will appear similar to the example. Refer to Figure 8-
13: Agent Terminal Displaying Queue Statistics on page 8-78.. 

3.2 Agent Terminal When Answering an ACD Call
IPK ACD Plus will send call information to the agent with every ACD
call that it transfers. This information is displayed on the answering
terminal’s LCD and will have the following format (QID is the name of
the ACD group and mm:ss is the hold time of this caller in
minutes:seconds format).

While on an ACD Call you can find out which Queue that the call was
transferred from by hitting the Help soft key.  

Figure 8-13:  Agent Terminal Displaying Queue Statistics

Figure 8-14:  Agent Terminal Answering an ACD Call
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SE C T I O N 4
SUPERVISOR TERMINAL 
INTERFACE

IPK ACD Plus will allow any terminal to become a supervisor terminal. The
terminal must be defined in the Administration Program. As a supervisor,
you are allowed to log into more than one queue at a time. Refer to 1.1
Logging into IPK ACD Plus Terminal Interface on page -72. 

As described in that section, a supervisor logs into IPK ACD Plus the same
way except that after successfully logged in, IPK ACD Plus will ask if you
wish to become an agent. 

SE C T I O N 5
RECORDING MESSAGES

This section provides information about recording Automatic Attendant (AA)
messages and numbers.

5.1 Recording an AA Message or AA Error Message

To record an AA message:

1. Press SK 2 (MSG).

2. Press SK 1 (AA).
 

Figure 8-15:  Supervisor Terminal Main LCD Display

Figure 8-16:  Selecting an AA Message to Record
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3. Press SK 1 (AA MSG) to record the AA greeting.
OR
Press SK 4 (AA ERROR) to record the AA error message that
informs callers of their invalid selection. 

4. Press SK 4 (RECORD). 

5. Record your message.

6. Press SK 4 (STOP) when you are finished recording your message. 
  

Figure 8-17:  Selecting AA Message to Record

Figure 8-18:  Selecting RECORD to Begin Recording

Figure 8-19:  Press STOP when Done Recording

STOP Pressing SK 4 (STOP) will stop recording.
EXIT Pressing the EXIT button returns the 

terminal to the message recording menu. 
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7. Do one of the following at the Accept/Play/Redo Message menu:

a) If you are satisfied with your recording, press SK 1 (ACCEPT).
IPK ACD Plus will replace the current AA message with your
newly recorded message.

b) If you want to hear the newly recorded message, press SK 3
(PLAY).

c) If you want to redo the recording, press SK 4 (REDO). 
     

8. After you press SK 1 (ACCEPT), IPK ACD Plus will display the AA
recording menu. You can continue recording or press the EXIT
button to return to the AA/ACD/NUMBERS recording menu.
Pressing the EXIT button again will return you to the main menu.

Figure 8-20:  Accept/Play/Redo Message Menu

ACCEPT Pressing SK 1 (ACCEPT) will replace the 
current AA message with your newly 
recorded message.

PLAY Pressing SK 3 (PLAY) plays back 
(through the terminal) the newly 
recorded message. 

REDO Pressing SK 4 (REDO) will start the 
recording of the message over.

EXIT Pressing the EXIT button returns the 
terminal to the message recording menu. 
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SE C T I O N 6
RECORDING AN ACD 
MESSAGE

There are eight different IPK ACD Plus messages that you can record from
your terminal. These ACD messages are stored on the Voice Mail
hardware. 

You can program the time between the ACD messages in the
Administration Program. The range for this period is 30 to 999 seconds
(default is 45 seconds). The time setting is the time IPK ACD Plus waits
between all of the ACD messages (i.e. the ACD greeting and the ACD
refresher message 1). For a description of each type of ACD message, refer
to Table 8-1: ACD Messages (Description and Default Message) on page 8-82.. 

Table 8-1:  ACD Messages (Description and Default Message)

ACD Message 
Name Description Default Message

Greeting Message The ACD Greeting 
Message greets callers 
only if there are no 
agents available to take a 
call.

“All agents are busy. 
Please hold.”

 Hold Message The Hold Message plays 
between the ACD 
Greeting Message and 
ACD Refresher Message 
1 (also between ACD 
Refresher Message 1 
and Refresher Message 
2). You can enable or 
disable the ACD On-Hold 
message per queue. The 
default is disabled.

There is no default 
message.

Night Message The Night Message plays 
when IPK ACD Plus is 
placed in Night Mode. 
The Night Message per 
Queue can be enabled or 
disabled. The default is 
disabled.

“We are closed. Please 
call back during 
business hours.”

Auto Attendant 
Error Message

The Error Message 
informs callers if they 
have made an invalid 
selection.

“You have made an 
invalid selection. Please 
try again.”
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ACD Refresher 
Message 1

The Refresher Message 
1 greets callers who have 
remained on hold (in 
queue) for a defined 
period. 
You will define the 
amount of time between 
queue messages. This 
message may be enabled 
or disabled per queue. 
The default is enabled. 
This message is 
automatically enabled if 
ACD Refresher Message 
2 is enabled. If ACD 
Refresher Message 2 is 
enabled, ACD Message 1 
will alternate at a user-
defined interval with ACD 
Refresher Message 2 for 
as long as the caller is in 
queue.

“Please continue to 
hold. An agent will be 
with you shortly.”

Refresher 
Message 2

The Refresher Message 
2 greets callers who have 
remained on hold (in 
queue) for a defined 
period. You will define the 
amount of time between 
the first refresher 
message and the second 
message. You can enable 
or disable the message 
per queue. The default is 
enabled. If Refresher 
Message 2 is enabled, 
the message will 
alternate at a user-
defined interval with 
Refresher Message 1 for 
as long as the caller is in 
queue.

“Please continue to 
hold. Your call is 
important to us.”

Table 8-1:  ACD Messages (Description and Default Message) (continued)

ACD Message 
Name Description Default Message
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Queue Status 
Header Message

The Queue Status 
Header Message will 
greet callers at the end of 
the following messages: 
Greeting Message, 
Refresher Message 1 
and Refresher Message 
2. 
You will not be required to 
record the number (x). 
The number (x) is a 
factory-recorded 
message and must 
handle numbers from 1 to 
64. IPK ACD Plus will 
update the queue status 
information to represent 
the actual status of the 
queue. You can enable or 
disable the Queue Status 
Header Message per 
queue. The default is 
enabled. 

“You are caller number 
x”, where x (spoken by 
the IPK ACD Plus) 
represents the caller’s 
order in their specific 
queue group.

Queue Status 
Trailer Message

The Queue Status Trailer 
Message will play after 
the Queue Status Header 
Message. You can enable 
or disable the Queue 
Status Trailer Message 
per queue. The default is 
enabled.

“In queue.”

Table 8-1:  ACD Messages (Description and Default Message) (continued)

ACD Message 
Name Description Default Message
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To Record an ACD Message:

1. Press SK 2 (MSG).

2. Press SK 2 (ACD). 

3. Press the softkey (SK) that corresponds with the queue that you
want to record the ACD message(s). Only those groups that have
been established, or you are assigned as a supervisor for,  are
displayed (i.e. if only two ACD groups are active then only two are
displayed.) 

4. Select the type of ACD message to record. Refer to the following
instructions and Figure 8-23: ACD Messages to Record on page 8-
86.. 

Figure 8-21:  Selecting ACD Message to Record

Figure 8-22:  ACD Selection Menu

ACD Greeting: Press SK 1 (GREET)
Hold message: Press SK 2 (HOLD)
Night message: Press SK 3 (NIGHT)
Error message: Press SK 4 (more) then press SK 1 

(ERROR)
Queue Status 
message:

Press SK 4 (more), press SK 3 (Q 
STATUS), then press SK 1 (HEADER) to 
record the Queue Status Header message 
or press SK 4 (TRAILER) to record the 
Queue Status Trailer message.

Refresh message: Press SK 4 (more), press SK 4 
(REFRESH), then press SK 1 (REFRESH 
1) to record the first Refresher message 
or SK 4 (REFRESH 2) to record the 
second Refresher message.
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5. Press SK 4 (RECORD) then record your message. Each message
can be up to 90 seconds long.

6. SK 4 (STOP) when you are finished recording your message.

7. Do one of the following at the Accept/Play/Redo Message menu:

a) If you are satisfied with your recording, press SK 1 (ACCEPT).
IPK ACD Plus will replace the current ACD message with your
newly recorded message.

b) If you want to hear the newly recorded message, press SK 3
(PLAY).

c)  If you want to redo the recording, press SK 4 (REDO).

8. After you press SK 1 (ACCEPT), IPK ACD Plus will display the ACD
recording menu. You can continue recording or press the EXIT
button to return to the AA/ACD/NUMBERS recording menu. Press
the EXIT button again will return you to the main menu.

Figure 8-23:  ACD Messages to Record

Figure 8-24:  Display After Pressing SK 4 (More)
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6.1 Recording Numbers
Once you begin to record the numbers, you must continue until the
ACCEPT prompt is displayed or the recording will be abandoned. 

To record the numbers:

1. Press SK 2 (MSG).

2. Press SK 4 (NUMBERS). 

3. Press SK 4 (RECORD) then record your message. The display will
show the number to be recorded. 

4. Press SK 4 (STOP) when you are finished recording your message. 

Figure 8-25:  Selecting Numbers to Record

Figure 8-26:  Numbers Play/Record Menu

Figure 8-27:  Recording Numbers with Stop Option
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5. Do one of the following at the Accept/Play Message menu:

a)  If you are satisfied with your recording, press   SK 1 (ACCEPT).
IPK ACD Plus will replace the current numbers with your newly
recorded message. 

b) If you want to hear the newly recorded message, press SK 3
(PLAY).

c)  If you want to redo the message, press SK 4 (REDO). 

6. After you press SK 1 (ACCEPT), IPK ACD Plus will display the
Numbers Recording menu. You can continue recording, or press the
EXIT button to return to the AA/ACD/NUMBERS recording menu.
Pressing the EXIT button again will return you to the main menu.

Figure 8-28:  Accept, Play, Redo Menu
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SE C T I O N 7
NIGHT MODE 
(SUPERVISOR 
TERMINAL)

7.1 Enabling/Disabling Night Mode For ACD Group(s)

To enable/disable Night Mode for ACD Group(s):

1. From the supervisor’s main LCD menu, press  SK3 (NIGHT).

2. Press softkeys (SK) of the queue/ACD group you want to enable/
disable the Night Mode. The current mode (Day Mode or Night
Mode) of IPK ACD Plus for the ACD Group, determines which of the
following prompts IPK ACD Plus will display. 

Currently In Day Mode
If IPK ACD Plus is currently in Day Mode for the ACD Group, IPK
ACD Plus displays the following prompt: 

Currently In Night Mode
If IPK ACD Plus is currently in Night Mode for the ACD Group, IPK
ACD Plus displays the following prompt:

3. Respond to the prompts accordingly by either pressing SK 3 (YES)
or SK 4 (NO).

Figure 8-29:  Night Prompt While in Day Mode

Figure 8-30:  Day Prompt While in Night Mode
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7.2 Night Mode Operation
When IPK ACD Plus is in Night Mode, Night Mode overrides all other
modes of operation. Night Mode may be set for each individual
queue. Night Mode operation can function in three ways: it can play a
user-recorded message and hang up, it can play a message and
transfer the caller to any valid internal phone number, or it can
directly transfer to any valid phone number via Centrex transfer.
Night mode can be initiated from an external supervisor terminal or
can be programmed to “follow” the Xen IPK into Night Mode. Refer to
7.3 Transfer Methods (Night Mode) on page -90.

7.3 Transfer Methods (Night Mode)
The following transfer methods are available while in Night Mode.

7.3.1 Message Without Transfer (Night Mode)
If there is an IPK ACD Plus message enabled but no
transfer number is programmed, IPK ACD Plus plays the
message then releases the call.

7.3.2 Message With Transfer (Night Mode)
If there is an IPK ACD Plus message enabled and a
transfer number is programmed, IPK ACD Plus plays the
Night Mode Message then transfers the call. The transfer
number may be any valid extension or external phone
number using a Centrex transfer.

7.3.3 Transfer Only (Night Mode)
If there is no IPK ACD Plus message enabled but a transfer
number is programmed, IPK ACD Plus transfers the call
immediately.

7.4 Logging Out of IPK ACD Plus
Press SK 1 (LOUT) on the terminal will log the agent out of the ACD
queue(s) and will return the terminal’s LCD to standard Xen IPK
operation. IPK ACD Plus will no longer monitor the terminal.
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IPK ACD Plus 
Administration Program Chapter 9

SE C T I O N 1
INTRODUCTION

The NEC IPK Automated Call Distribution (ACD) Plus Administration
Program is a windows-based software application that allows you to
perform all facets of IPK ACD programming via a personal computer (PC)
connected to a serial port or LAN port on the ACD Plus card. You will also
be able to transfer voice files from the PC to the IPK ACD Plus. These voice
files can be used for any of the Auto Attendant (AA), ACD, or Night Mode
messages and would take the place of manually recording those messages.

SE C T I O N 2
LOGGING ON

To log on:

1. From the Windows Start Menu, choose IPK ACD Plus Suite, then
choose ACD+ Admin, or if you have an icon on your desktop, click
the icon.

2. Click on the Get Configuration from KSU button.

3. Type in the server name or IP (Internet Protocol) address if running
ACD Plus Admin on Remote PC. See the network administrator if the
server IP address or name cannot be determined.

4. Type your Login Name. (The default Login name is nec.) 

5. Type your Password. (The default password is password.)

Figure 9-1:  Logon Window
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If you have an invalid user name and/or password, the following message
box will appear: 

If you enter an incorrect user name and/or password three consecutive
times, the Administration Program will automatically close.

SE C T I O N 3
LOGGING OFF

To log off:

1. From the File menu, choose Exit, or click the close icon in the upper
right-hand corner of the window.

2. Click Yes at the ‘Do you want to exit IPK ACD Plus Admin?’ prompt. 

3. Click Yes at the ‘Do you want to save changes made in IPK ACD Plus
Admin?’ prompt.

Figure 9-2:  Invalid Password Message

Figure 9-3:  IPK ACD Plus Administration Exit Message

Figure 9-4:  Save Changes Prompt
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SE C T I O N 4
WORKING LOCALLY 
(NOT CONNECTED TO A 
SERVER)

1. From the Windows Start Menu, choose IPK ACD Plus Suite, then
choose ACD+  Admin, or if you have an icon on your desktop, click
the icon. 

2. Click the Get Configuration from File button.

3. Select the configuration file by clicking Open.

Figure 9-5:  Opening the Configuration File



June 2004 NEC Business Solutions Ltd

94 – Chapter 9 IPK ACD Plus Administration Program

D
oc

. N
o.

 8
31

0 
- R

el
ea

se
 1

.0
Ju

ne
 2

00
4

SE C T I O N 5
QUEUES TAB

From the Queues tab, you can assign agent ID numbers to ACD Groups.
Agent IDs that were setup from the ID/Administration tab will appear in the
Agents box. From this area, you can click and drag an Agent ID to one or
more queues. Each queue lists the Agent’s ID, Name, and Level in Agent ID
order.

5.1 Adding an Agent to a Queue or to Multiple Queues
To add an agent to a queue:

1. From the Queues tab, click the Agent ID located in the Agent’s
box that you want to move.

2. Drag and drop to your queue of choice. 

You can add an agent ID to multiple queues. If so, you will need
to confirm your action by clicking Yes at the ‘Agent already in
Group’ pop-up message box. 

Figure 9-6:  Queues Tab

Figure 9-7:  Agent Already in Group Pop-up Message
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5.2 Copying an Agent to a Different Queue

To copy an agent to a different queue:

1. From the Queues tab, left mouse click and then right mouse click
on the Agent cell to be copied to another queue.

2. Choose Copy.

3. Click the cell of the new queue where the agent is to be placed.

4. Right mouse click and choose Paste.

5.3 Moving an Agent to a Different Queue

To move an agent to a different queue:

1. From the Queues tab, left mouse click and then right mouse click
on the Agent cell that is to be moved to another queue.

2. Choose Cut.

3. Click the cell of the new queue where the agent is to go.

4. Right mouse click and choose Paste.

5.4 Deleting an Agent from a Queue

To delete an agent from a queue:

1. From the Queues tab, left mouse click and then right mouse click
on the Agent ID to be deleted from the queue.

2. Choose Delete.

3. Click Yes at the ‘Are you sure you want to delete agent?’ prompt.

Figure 9-8:  Delete Agent Confirmation Prompt
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5.5 Changing an Agent’s Preferred Level in the Queue

To change an Agent’s preferred level in the queue:

1. From the Queues tab, left mouse click and then right mouse click
on the preferred level cell of the Agent.

2. Select the preferred level from the drop-down list. Preferred
levels are 1~9. The default preferred level is 1.

5.6 Changing a  Queue Name

To change a queue name:

1. Right mouse click on the ACD Group Name or select the ID
icon.

2. Type a new name with a maximum length of eight digits. Once a
name has been changed, the name will remain resident in the
program.

3. Click Accept.

Figure 9-9:  Update an ACD Group Name
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5.7 Changing Queue Settings

To change queue settings:

1. From the Queues tab, select the Set icon or double-click the
ACD Group Name.

2. From the Options Menu, make changes to the defaults, as
needed.

3. Click Exit to save any changes and exit the screen. 

The options available on the ACD Options Menu include:

Night Service
In night mode, all calls are directed to the ACD Group that is routed
to the Night Service number. The night service box is blank by
default.

Night Mode Enable Dialling
Enables or disables direct dialling to a valid extension by the caller
when the queue is in Night Mode. The caller can only dial while the
greeting is played.

KSU Night Service
Sets the group to follow the telephone system Night Mode, or to
ignore it.

Enable Direct Dialling
Enables or disables Direct Dialling to a valid extension by the caller
during Day Mode. The caller can only dial while the greeting is
played.

CAR
The CAR box is used to enter the pilot number for this queue’s Call
Arrival Key (CAR). This is where a call would be directed for a
particular queue.

Figure 9-10:  ACD Options Menu
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Messages
Check the messages that you want to apply. Refer to Section 7
Upload Message Tab on page -100 for a complete description of each
message type.

Overflow Threshold
Overflow Threshold will send a caller from the queue to the Overflow
Destination. You can set the Overflow Threshold by  the time spent
in queue into the text entry box. After you enter the number of
seconds, click the Seconds box. The default value is a blank text
entry box with the None option checked. 

Overflow Destination
The Overflow Destination number is the number to transfer the caller
to when the Overflow Threshold has been reached. Valid entries in
this area include other queues, extensions, external numbers using
the trunk access code and/or a Centrex hookflash (J) followed by
the destination number. Spaces, dashes, and parentheses are
allowed. If the Overflow Threshold has been selected to be “None”,
then the Administration Program automatically enters “None” as the
Overflow Destination number. A drop-down list offers a “None”
choice and names of the queues.

Distribution
Choose the distribution by selecting the correct value. The values
are: Preferred and Longest Idle.
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SE C T I O N 6
TRUNKS TAB

The Trunks tab allows you to assign trunk lines that are to be answered by
the IPK ACD Plus Auto Attendant and ACD groups. IPK ACD Plus
Administration will allow a trunk to be answered by only one single function
(AA, ACD Group1, ACD Group 2, etc.). 

The options available on the AA Trunk Groups tab menu include:

Available Trunks
The Available Trunks area shows all available trunk lines that you can
choose to assign to the appropriate AA or ACD Trunk Group. You can drag
and drop the trunks into a group using the mouse. A trunk can be added to
only one group or Auto Attendant.

Trunks
The list of trunks for that particular group.

# Rings Before Answer
You can set the number of rings (0~9) for each line before IPK ACD Plus
greeting. To change the number of rings before answering, click the right
mouse button on the number desired to change.

Transfer Destination
Enter the AA transfer destination number in the “Transfer Destination” field.
Valid entries in this field include extensions, external numbers, and a
Centrex “hook-flash” (J) followed by the destination number. Spaces,
dashes, and parentheses are allowed. The Transfer Destination for ACD
groups are automatically set to N/A, and  data can not be entered into the
field. 

Figure 9-11:  AA Trunk Groups Tab
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6.1 Moving a Trunk from a Queue
To move a trunk from a queue:

1. From the Trunks tab, left mouse click and then right mouse click
on the cell to be moved to another queue.

2. Choose Cut.

3. Click the tab of the queue the trunk is to be moved to.

4. Left mouse click and then right mouse click and choose Paste.

6.2 Deleting a Trunk from a Queue

To delete a trunk from a queue:

1. From the Trunk tab, left mouse click and then right mouse click
on the trunk cell that is to be deleted from the queue.

2. Choose Delete.

SE C T I O N 7
UPLOAD MESSAGE TAB

The Upload Message Tab allows anyone with administrator privileges to
upload message files from a PC into IPK ACD Plus. The time limit on any
single message is 90 seconds.

The messages available on the Upload Message Tab include:

Auto Attendant Messages
The greeting recorded here is used for all queues. There is no message at
default. It can be used to prompt a caller for action.

Figure 9-12:  Upload Message Tab
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ACD Greeting Message
The ACD Greeting Message greets callers only if there are no agents
available to take a call or transfer after Greeting is checked in the
Configuration of the KSU Parameters tab. If an agent is available, the call is
sent directly to that agent. This message only plays if the ACD functionality
is enabled. 

The default message is:

“All agents are busy. Please hold.”

ACD Refresher Message 1
The ACD Refresher Message 1 greets callers who have remained on hold
(in queue) for a defined period. 

The default message for the ACD Refresher Message 1 is:

“Please continue to hold. An agent will be with you shortly.”

The amount of time between queue messages can be defined. This
message may be enabled or disabled per queue. The default is enabled
(provided the ACD functionality is enabled). This message will automatically
be enabled if ACD Refresher Message 2 is enabled. If ACD Refresher
Message 2 is enabled, ACD Message 1 will alternate at a user-defined
interval with ACD Refresher Message 2 for as long as the caller is in queue.

ACD Refresher Message 2
The ACD Refresher Message 2 greets callers who have remained on hold
(in queue) for a defined period. 

The default message for the ACD Refresher Message 2 is: 

“Please continue to hold. Your call is important to us.” 

The amount of time between the first ACD refresher message and the
second message can be defined. This messages can be enabled or
disabled per queue. The default is enabled (provided the ACD functionality
is enabled). If ACD Refresher Message 2 is enabled, the message will
alternate at a user-defined interval with ACD Refresher Message 1 for as
long as the caller is in queue.

ACD Queue Status Header Message
The ACD Queue Status Header Message will greet callers at the end of the
following messages: ACD Greeting Message, ACD Refresher Message 1
and ACD Refresher Message 2. 

The default ACD Queue Status Header Message is: 

“You are caller number x”, where x (spoken by the IPK ACD Plus)
represents the caller’s order in their specific queue group. 
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The number (x) is not required to be recorded by the user. The number (x)
will be a factory-recorded message. IPK ACD Plus will update the queue
status information to represent the actual status of the queue. You can
enable or disable the ACD Queue Status Header Message per queue. The
default is enabled. 

ACD Queue Status Trailer Message
The ACD Queue Status Trailer Message will play after the ACD Queue
Status Header Message. 

The default ACD Queue Status Trailer Message is:

“In queue.” 

You can enable or disable the ACD Queue Status Trailer Message per
queue. The default is enabled. 

ACD On-Hold Message
The ACD On-Hold Message will play between the ACD Greeting Message
and ACD Refresher Message 1 (also between ACD Refresher Message 1
and Refresher Message 2). There will be no default ACD On-Hold
Message. You can enable or disable the ACD On-Hold message per queue.
The default is disabled.

Night Mode Message
The Night Mode Message plays when IPK ACD Plus is placed in Night
Mode. This message can be enabled or disabled per queue. The default is
disabled.

7.1 Uploading a Message
1. To upload a message file, select a message from the message

grid by double-clicking the cell. For all messages except the Auto
Attendant Message, you will be required to select the name of
the ACD group (indicated below by Q1-Q4) for which they wish to
upload a message.

2. When a message (and an ACD group, where appropriate) has
been selected, you are prompted for the path to the sound file
using a pop-up message box. Refer to Figure 9-13: Locating Path
for Message Window on page 9-103..

3. The message name and ACD group designation will appear at
the top. The path will be a text box that allows the user to enter
the path and file name. If you need to browse, change drives,
and/or open file folders, as needed, until the file name appears in
the path box.

4. Click OK.

All prompts must be formatted as 8kHz ADPCM OKI. If not
properly formatted, the message will not function. 
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In addition the Numbers prompt must be in Index Play format. If
not properly formatted, the queue depth feature will not function.

SE C T I O N 8
CONFIGURATION TAB

The Configuration Tab contains three sub-tabs for customising IPK ACD
Plus features.

8.1 Terminals Tab
The Terminals sub-tab allows information about the terminal to be
entered.

The following items are available on the Terminals Tab:

DN
Destination Number. Any valid DN that is allowed as an agent or supervisor
terminal.

Figure 9-13:  Locating Path for Message Window

Figure 9-14:  Terminals Tab
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BLF Port 
Port on the ACD card on which the agent/supervisor terminal  indication will
appear.

BLF Number
One touch key on the ACD port that represents a particular agent/
supervisor terminal.

To add a new terminal:

1. From the Configuration tab, the Terminals tab shows BLF Port and
BLF Number for each DN. Right mouse click on the DN.

2. Choose New.

3. Enter the DN.

4. Enter the BLF Port Number (ACD port number 1~8).

5. Enter the BLF Number (one-touch key on ACD port 1~20).

6. Click Accept. 

Figure 9-15:  New Terminal
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8.2 Auto Attendants Tab
The Auto Attendants sub-tab allows defining of the transfer
destinations for the Auto Attendant (AA) options. 

Selection
AA option (the number selected by the caller).

Destination
The Transfer destination may be one of the following:

ACD Group
DN (Destination Number)
Offsite number (Offsite numbers must always start with a
“J,” to provide a hook-flash to the CO for a Centrex transfer.)

Enable Direct Dial
Direct Dial allows a caller to dial an extension directly while a
message is being played. The “Enable Direct Dial” box is used to
enable/disable this feature. 

Figure 9-16:  Auto Attendants Tab
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8.3 KSU Parameters Tab 
The KSU Parameters sub-tab allows Key System Unit information to
be entered. 

Line Seizure Access Code
Dial access code for Line Seizure Access.

Digits in Dialling Plan
One-digit number corresponding to the Dialling Plan being used.

Operator Number
Extension number for the operator switchboard.

Call Pickup Direct Access Code
Access code used for picking up calls.

Interdigit Time (secs)
The time a caller can wait between digits when dialling an extension
or following an Auto Attendant prompt. Default is four seconds.

Time Between ACD Messages (secs)
Time that the system waits between playing the ACD messages.
Time can be set from 30 seconds to 999 seconds. Default is 45
seconds.

Time Agent Rings Without Answer (secs)
Time the system rings the Agent before the call is recalled. Time can
be set from 12 seconds to 99 seconds. Default is 15 seconds.

Figure 9-17:  KSU Parameters Tab
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DNs
Stations that will be used as agents and supervisor’s terminals. Up to
108 may be selected.

To add DNs:

1. Select Digits in Dialling Plan, if needed. Permitted values are 2,
3, or 4 digits.

2. Click on the box next to the extension number of the station that
is to be used as an agent.

3. Enter the BLF Port and the BLF Number for that extension. Refer
to 8.1 Terminals Tab on page -103 for instructions on how to add a
new terminal.

OR

Enter the first extension number of the stations in the DNs Start
position and select Configuration. This will automatically assign the
next 108 DNs. You can deselect the DNs you do not want. If more
than 108 DNs are selected, a pop-up error message will appear.
Refer to Figure 9-18: Only 108 Terminals Maximum Allowed
Message on page 9-107.. 

Transfer After Greeting
This is a system-wide setting effecting all queues. When this box is
checked, the system will always play the ACD Greeting before
transferring the call to an available agent for each new call to each
queue. When this box is not checked, a new call will be sent to an
agent, if available, without playing any greeting. If no agents are
available, the system will play the appropriate greetings until an
agent becomes available.

Transfer Destination
The Transfer Destination setting is used to set the first digit for valid
extension number designations in the KSU for the ACD to transfer
calls to. Whatever extension numbers are allowed in the KSU
programming should be checked here. For example, in KSU
programming (at default) extension numbers can start with 1, 2, or 3.
In this case, the boxes 1XX, 2XX, and 3XX should be checked. If the
valid numbers had been changed in KSU programming to the 400,
500, and 800 range you would check 4XX, 5XX, 8XX. 

Figure 9-18:  Only 108 Terminals Maximum Allowed Message
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SE C T I O N 9
ID/ADMINISTRATION TAB

The ID/Administration Tab contains three sub-tabs.

From the ID/Administration Tab you can add and change passwords for
agents, supervisors and the administrator.

9.1 Agent Tab
The Agent tab allows you to add, change, or delete agent logon
information.

Agent ID
Number assigned to the agent.

Name
Name of the agent (keep names short to help with the display of
graphs).

Password
Up to an eight digit password for the agent to log in to IPK ACD Plus
using the telephone keypad. Valid entries include: K~I,
J,L.

To add an Agent ID:

1. From the ID/Administration’s Agent tab, right mouse click on
Agent ID and select New, or click the New tool button.

2. Type the Agent’s ID. The ID can be up to four digits long.

3. Type the Agent’s Password. The password can be up to eight
digits long, including the Jand Lkeys.

4. Type the Agent’s Name (up to ten characters).

Figure 9-19:  Agent Tab
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5. Click Accept. 

To modify an agent ID:

1. From the ID/Administration’s Agent tab, right mouse click on the
Agent’s Name, then choose Modify, or click the Change tool
button.

2. Change the Agent’s ID (can be up to four digits long), Password
(can be up to eight digits long, including the J and L keys),
and Name (can be up to ten characters).

3. Click Accept.

Figure 9-20:  Adding an Agent ID

Figure 9-21:  Modify Agent Information Window
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To delete an agent ID:

1. From the ID/Administration’s Agent tab, highlight the Agent’s ID,
right mouse click on Agent ID, then select Delete, or click the
Delete tool button.

2. Click Yes at the ‘Are you sure you want to delete Agent?’ prompt.

9.2 Supervisor Tab
From the Supervisor Tab, you can add, change, or delete the
supervisor’s logon information. 

Supervisor ID
Number assigned as the supervisor’s identification number for
logging onto IPK ACD Plus.

Supervisor Password
Number assigned as the supervisor’s password for logging onto IPK
ACD Plus.

Figure 9-22:  Deleting an Agent ID

Figure 9-23:  Supervisor Tab
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Supervisor Name
Name of the Supervisor (keep names short to help with the display
of graphs).

Q1, Q2, Q3, Q4
Y/N  (Y=Supervisor can monitor and record messages for that
queue).

Level
1~9 (What preferred agent level is the supervisor if they log in as an
agent).

To add a Supervisor ID and Password:

1. From the ID/Administration’s Supervisor tab, right mouse click on
Supervisor ID, then select New or click the New tool button.

2. Type the Supervisor ID. The ID number can be up to four digits
long.

3. Type the Supervisor’s Password. The password can be up to
eight digits long, including the J and L keys.

4. Type the Supervisor’s Name (up to 10 digits).

5. Click Accept.

6. Left mouse click, then Right mouse click. Choose Yes for the
Queue number(s) that you want the Supervisor ID to be a
Supervisor of.

Figure 9-24:  Adding a New Supervisor Information
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To modify a Supervisor ID:

1. From the ID/Administration’s Supervisor tab, highlight the
Supervisor’s Name, right mouse click on the Supervisor’s
Name, then choose Modify or click the Change tool button.

2. Change the Supervisor’s ID (can be up to four digits long),
Password (can be up to eight digits long, including the J and
L keys), and Name (can be up to 10 characters).

3. Click Accept. 

To delete a Supervisor ID:

1. From the ID/Administration’s Supervisor tab, highlight the
Supervisor’s name, right mouse click on Supervisor ID, then
select Delete, or click the Delete tool button.

2. Click Yes at the ‘Are you sure you want to delete Supervisor?’
prompt. 

Figure 9-25:  Modifying a Supervisor ID and/or Password

Figure 9-26:  Deleting a Supervisor ID
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9.3 Administrator Tab
From the Administrator tab you can add, change, or delete
Administrator logon information. 

To add a New Administrator ID:

1. From the ID/Administration’s Administrator tab, right mouse click
on Username ID, then select New or click the New tool button.

2. Type the Administrator’s User Name. The name must be at least
four characters long. 

3. Type the Administrator’s Password. The password must be at
least four digits and a maximum of eight digits, including the J
and L keys.

4. Click Accept.

Figure 9-27:  Administrator Tab

Figure 9-28:  Adding a New Administrator ID
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To modify an Administrator ID:

1. From the ID/Administration’s Administrator tab, highlight the
Username, right mouse click on Username ID, then choose
Modify or click the Change tool button.

2. Change the UserName ID (must be at least four characters
long), and  Password (can be up to eight digits long, including
the J and L keys).

3. Click Accept. 

To delete an Administrator ID:

1. From the ID/Administration’s Administrator tab, highlight the
Username, right mouse click on Username ID, then select
Delete or click the Delete tool button.

2. Click Yes at the ‘Are you sure you want to delete Administrator?’
prompt.  

Figure 9-29:  Modifying an Administrator ID

Figure 9-30:  Deleting an Administrator ID
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Optional Wallboard  
Support Chapter 10

SE C T I O N 1
WHAT DRIVES THE 
WALLBOARD?

The server will drive a wallboard using a different serial port on the PC then
the one utilised by the KSU.

The monitor program will drive a wallboard using any open COM port on
the PC.

In either case, wallboard support must be turned on by utilising the
wallboard menu under the Preferences Menu.

SE C T I O N 2
HOW DOES THE 
WALLBOARD DISPLAY 
INFORMATION?

The wallboard displays each active queue’s information (queue name,
number of agents logged in, number of callers on hold, and the time the
longest caller has been on hold). 

Statistics for each queue is displayed for five seconds after which the
statistics for the next queue appears. For installations with only one queue,
the queue information remains on the wallboard.
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Learning About the Real
Time Display (RTD) Chapter 11

SE C T I O N 1
LAYOUT OF THE 
DISPLAY

The Real Time Display (RTD) provides current statistics for each of the
ACD queues. Refer to Figure 11-1:, Real Time Display on page 117. 

For each queue, the RTD lists the following statistics: 

By default, the top line on the RTD shows the headers for each statistic
column. The bottom row of the RTD shows text messages, as they are
received from other users.

Figure 11-1:  Real Time Display

Agents: Number of agents logged into the queue.

In Queue: Number of calls waiting in the queue.

Longest: Wait time for the call that has been in queue 
the longest. 
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The bottom of the RTD frame provides a menu button and connectivity
indicator. Refer to Figure 11-2:, Menu and Connectivity Buttons on page
118. 

Details on customising the appearance of the RTD will be discussed next.

1.1 Turning Headers Off/On

To disable headers from being displayed:

1. Click the Menu button on the RTD image.

2. Select the Setup option on the RTD menu.

3. On the Setup menu, click on Display Headers to disable this
option.

4. Click on OK to save the changes.

To enable the display of headers:

1. Click the Menu button on the RTD image.

2. Select the Setup option on the RTD menu.

3. On the Setup menu, click on Display Headers to enable this
option.

4. Click on OK to save the changes.

Figure 11-2:  Menu and Connectivity Buttons

Menu
Button

Connectivity
Button
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1.2 Resizing the RTD Image
The RTD image can be displayed in two different sizes: Large View
and Small View. The image can also be set to a minimised state in
the taskbar. 

The following steps can be used to select a different image size.

To select the Large View:

1. Click the Menu button on the RTD image.

2. Select the Large View option on the RTD menu.

To select the Small View:

1. Click the Menu button on the RTD image.

2. Select the Small View option on the RTD menu.

To minimize the RTD Image:

1. Click the Menu button on the RTD image.

2. Select the Minimize option on the RTD menu.

1.3 Repositioning the RTD Image

To move the RTD Image:

1. Position the mouse cursor within the RTD image.

2. While holding down the left mouse button, drag the image to the
new screen position.

3. Release the mouse button to drop the image at the new location.

1.4 Keeping the RTD Image Visible

To keep the RTD Image on the topmost applications:

1. Click the Menu button on the RTD image.

2. Select the Setup option on the RTD menu.

3. On the Setup menu click on Always On Top to enable this
option.

4. Click on OK to save the changes.
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SE C T I O N 2
TEXT MESSAGING 
CAPABILITY

The Real Time Display (RTD) application allows text messages to be sent
between RTD clients. This capability can be used to send general
announcements to groups of users or direct comments to individual agents.
All RTD clients can receive text messages, however, the ability to send text
messages is controlled through settings in the server (Elite ACD Plus
Server).

Only RTD clients that are connected at the time a text message is sent will
receive the message.

When an RTD client receives a text message, the message is scrolled
across the bottom line of the display. The message will continue to scroll
until the message duration has expired or the user selects the Clear
function. If multiple messages are received, the messages will be displayed
in sequence in the order in which they were received.

2.1 Sending a Text Message

To send a text message:

1. Click the Menu button on the RTD image.

2. Select the Message option on the RTD menu.

3. Type the desired text into the message area.

4. To change the text colour, use the mouse to select the text string
to be changed. Click on the Set Colour button and select the
new colour from the colour palette.

5. Double-click on each entry in the Agents list to receive the text
message. Each selected entry is listed in the Recipients list.

6. To remove an entry from the Recipients list, use the right mouse
button to select the entry and click on the Delete option.

7. Set the display period for the message by entering a numeric
value in the Duration field, and then select the desired time units
(seconds, minutes, hours, or Continuous). Selecting the
Continuous option will display the message until the recipient
uses the Clear function to remove the message.

8. Click on Send to deliver the message.

2.2 Clearing Text Messages

To clear text messages from the display:

1. Click on the Menu button on the RTD image.

2. Select the Clear option on the RTD menu.
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2.3 Setting a Text Message Alert
The RTD client can be configured to play an alert tone when a new
message arrives, and the application can also be set up to pop up
from a minimises state when a message arrives. 

To play an alert tone when text messages arrive:

1. Click on the Menu button on the RTD image.

2. Select the Setup option on the RTD menu.

3. On the Setup menu, click on Chime on Message to enable this
option.

4. Click on OK to save the changes.

To set a pop up when a text message arrives:

1. Click on the Menu button on the RTD image.

2. Select the Setup option on the RTD menu.

3. On the Setup menu, click on Popup on Message to enable this
option.

4. Click on OK to save the changes.

SE C T I O N 3
QUEUE THRESHOLDS

Thresholds can be defined on the server (ACD Plus Server) for each of the
statistics shown on the Real Time Display. The thresholds represent critical
levels that indicate the efficiency of the call center operations. 

Threshold levels are shown on the RTD by changing the colour of the
individual statistic when the threshold is reached. A green level represents
the value for that field being in an acceptable range. A value is displayed in
yellow when a warning level has been reached for that field. A critical
threshold level is indicated by a red value.

The green/yellow/red progression is the default colour scheme defined within
the server. Your system may have been configured to use other colours.

The RTD can also be set to play a tone as a threshold level is met, or to pop
up the application when a threshold level is reached.
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3.1 Playing a Tone for Threshold Levels

To play a tone when a threshold level is reached:

1. Click on the Menu button on the RTD image.

2. Select the Setup option on the RTD menu.

3. On the Setup menu, click on Beep on Threshold to enable this
option.

4. Click on OK to save the changes.

3.2 Popping up the Application for Threshold Levels

To pop up the minimised application when a threshold is
reached:

1. Click on the Menu button on the RTD image.

2. Select the Setup option on the RTD menu.

3. On the Setup menu, click on Popup on Threshold to enable this
option.

4. Click on OK to save the changes.

SE C T I O N 4
TROUBLESHOOTING

This section provides helpful tips for troubleshooting certain problems that
may develop when running RTD. 

“No Active Queues” message
If the RTD application starts, and the message “No active queues” is
displayed without a user prompt to login, then this indicates the RTD client
cannot establish communication with the server. 

Perform the following checks to ensure that the RTD client is setup to
successfully communicate with the server.

Ensure that the server (ACD Plus Server) is running on the server PC.
Open the Setup menu on the RTD client and ensure that the correct IP
name/address is set in the Server Name field. The Port Number field
must be set to 6543.

On the RTD client PC, open a DOS window and try to “ping” the server
PC.

After communication between RTD client PC and server has been
verified, select the Login function on the RTD client.
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Statistics stop updating
If the connection indicator turns red and the statistics are no longer
updating, then this indicates that the RTD client has lost communication
with the server. 

Perform the following checks to help determine the cause of the problem:

Ensure that the server (ACD Plus Server) is still active on the server PC.

On the RTD client PC, open a DOS window and try to “ping” the server
PC.

After communication between RTD client PC and server has been
verified, select the Connect function on the RTD client.

“Agent Already Connected” message
When attempting to login, if the message “Agent Already Connected” is
displayed, this indicates that another PC has logged into the server using
the specified ID. Determine the location of the other user that is using the ID
and have that user exit the RTD client application. Then, select the Login
function at the new location and proceed with the login process.

“Maximum Number of Users Exceeded” message
When attempting to login, the message “Maximum Number of Users
Exceeded” indicated the server cannot currently accept any additional
logins from RTD clients. The ACD Plus Server is configured with a fixed
number of client licenses that control the number of RTD applications that
can be connected to the server.

To check the number of clients allowed by the server, look at the bottom
status bar on the server main window. This area displays a message such
as RTD Connections: 2 of 3, which indicates the number of users currently
connected and the maximum number of clients allowed.

RTD Client Key
Three RTD Clients can be connected without the using a RTD Client Key. If
more than three RTD Clients are needed, the RTD Client Key must be
placed on the PC running Elite ACD Plus SERVER. This RTD Client Key
will allow up to 100 RTD Clients to be connected.

Agent ID Not Included in Agent List
During the login sequence the Agent List displays the agent IDs for all users
that are allowed to use the RTD. If your agent ID does not appear in this list,
then either you do not have access to login to the RTD, or your agent ID is
already logged into the RTD on another PC.

To determine which of these situations is causing the problem, go to the
server PC and perform the steps listed next.

1. On the Preferences menu, select the RTD Clients option.

2. Find your Agent Name within the RTD Client table.
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3. If the icon next to your Agent Name is green, this indicates that a client
PC is already connected to the server.

4. If the Authorised Client column is not checked, then this agent is
prohibited from connecting to the server.

Display Only Shows Logged In Queues
Each RTD client can be configured to display all queues that the agent is
authorised to log into or just the queues that the agent is currently logged
into. This option is set in the server on an agent by agent basis.

To change the displayed queues for an individual client:

1. On the ACD Plus Server, open the Preferences menu and select the 
RTD Clients option.

2. Find the row within the agent list that contains the agent entry to be
changed.

3. Click on the Active Queues column to change the current setting for
the desired agent.

4. Click OK to save the settings.

Message Option is Disabled
The ability to send text messages from the RTD client is controlled on an
agent by agent basis. The settings that determine which agents have this
feature are defined within the server.

To enable the Message option for an individual agent:

1. On the server (ACD Plus Server), open the Preferences menu and 
select the RTD Clients option.

2. Find the row within the agent list that contains the agent entry to be
changed.

3. Click on the Text Messaging column for the desired agent to change
the current setting.

4. Click OK to save the settings.

Changing the Default Colour for Text Messages
When the Message feature is selected, the Create Text Message window
opens and allows the user to define the characteristics of the text message.
The colour of individual words or phrases can be changed to emphasize
certain elements of the text.

To change the colour of a section of text:

1. Position the mouse cursor at the beginning of the phrase to be altered.

2. While holding down the left mouse button, drag the mouse cursor to
the end of the phrase. This will highlight the entire phrase to be
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modified.

3. Click on the Set Colour button to open the colour palette.

4. Select the desired colour and click on OK.

Within the Create Text Message menu, the Sample Text area shows the
default colour that will be used when text is entered. This will be the default
colour each time the Create Text Message menu is opened, unless the
colour is changed using the steps that follow.

To change the default colour for text messages:

1. When the Create Text Message menu is first opened, press the Set 
Colour button before entering any text.

2. Select a new default colour from the colour palette menu.

3. Click OK on the colour palette menu to return to the Create Text
Message menu.

4. Enter the message text and specify the desired recipients.

Click on Send to deliver the text message.
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